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PROGRAMAREA IN .NET - PARTEA A 17-A RAPOARTE IN ASP.NET –WINDOWS FORMS

 114 

Programarea in .NET - partea 1 - Inceputurile  
Acesta este un prim articol dintr-o serie care vrea sa prezinte programarea in .NET( Windows si 
Internet) pe intelesul incepatorilor.  

Ca sa puteti urma acest mini-curs, trebuie sa aveti cunostinte minime de programare.Nu o sa va 
fac teoria variabilelor, nici nu o sa va tin un curs de SQL si nici despre programarea 3-tier. 
Exemplele date vor fi facute in C# -dar ele se pot trece la fel de bine in VB.NET sau orice alt 

limbaj pe care .NET il suporta.Pentru mai multe limbaje, accesati adresa : 
http://www.dotnetpowered.com/languages.aspx  
Ceea ce o sa ne intereseze in acest tutorial este partea de programare a lui .NET.  

 
Codul final este la adresa  

http://serviciipeweb.ro/iafblog/content/binary/book2.zip 
 
De ce aveti nevoie: 

1. Un calculator cu Windows instalat( de preferinta , orice de la XP in sus)  
2. IIS pentru proiectul Internet . Vedeti daca exista in Control Panel => Administrative Tools => 

Internet Information Services (IIS) Manager.  
Daca nu, duceti-va la Control Panel => Add Or Remove programs => add / remove Windows 
components si il gasiti acolo 

3. MSDN 2006 May - pentru tutoriale si exemple - free 
:http://www.microsoft.com/downloads/details.aspx?FamilyID=373930CB-A3D7-4EA5-B421-

DD6818DC7C41&displaylang=en 
4.SQL Server Express - free : http://msdn.microsoft.com/vstudio/express/sql/download/ 
4. Visual Studio Web Development Express  free  - pentru proiecte internet - 

http://msdn.microsoft.com/vstudio/express/vwd/) 
5. Visual C# Express  free  - pentru proiecte windows -

 http://msdn.microsoft.com/vstudio/express/visualcsharp/) 
6. Optional : ReportViewer Control in Visual Studio 2005 free - pentru raportari locale - 
http://www.gotreportviewer.com/ 

  
Dupa ce ati downloadat si instalat aceste programe, prima aplicatie pe care o sa o facem este un 

proiect cu baze de date prin care o sa indexam cartile din biblioteca proprie.  
Proiectul o sa fie schematic, doar pentru demonstrarea programarii Windows si Internet cu .NET.  
Elementele principale ale proiectului or sa fie Cartea , Autorul si Editura 

  
Atributele principale ale Cartii sunt : 

Titlu 
Data Aparitiei 
ISBN 

Editura ( presupunem ca 1 carte nu este editata de mai multe edituri)  
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Atributele principale ale Autorului sunt : 

Nume  
Prenume 

  
Atributele principale ale Editurii sunt: 
Nume 

SiteWeb 
  

O carte poate avea mai multi autori, iar un autor poate aparea pe mai multe carti ( legatura multi 
la multi) 
O carte poate avea o singura editura , dar o editura poate publica mai multe carti 

  
Ce se cere : 

- forme de introducere a celor 3 obiecte 
- cautare in baza de date dupa : Editura, Carte, Autor 
- afisarea obiectelor in functie de relatiile dintre ele ( de exemplu, daca se selecteaza un autor, sa 

se afiseze toate cartile scrise de el ) 
  

Pina atunci, astept intrebarile voastre la adresa :contact@serviciipeweb.ro 
Lecturi  Recomandate 

Charles  Petzold, DotNetBookZero – pentru incepatorii in .NET si nu numai 

http://www.charlespetzold.com/dotnet/ 

How to be a Programmer: A Short, Comprehensive, and Personal Summary 

http://samizdat.mines.edu/howto/HowToBeAProgrammer.html 

programarea in .NET - partea a 2-a - creerea bazei de date  

Conventie : notarile si codul si comentariile or sa fie in engleza. Nu de alta -dar e limba 
internationala a programarii.  

 
Bun - acum ca ne-am lamurit ce vrem sa facem, hai sa concepem Baza de date.  
Aceasta o sa fie, pentru Windows forms, Access - iar pentru ASP.NET - SQL Express. 

De ce aceasta alegere ? Simplu : 
Pentru aplicatia Windows forms - aleg ceva care sa fie usor de facut deployment-ul 

Pentru aplicatia ASP.NET - trebuie sa fie ceva care sa mearga repede - deci un SQL Server se 
impune 
Cum o sa facem sa generam cod pentru oricare din acestea doua, o sa vedeti.  

 
Structura Proiectului: 

O sa cream proiectul in C:\Book 
In acest director vom crea BookWin.sln ( solutia care va tine proeictul windows si proiectul 
Consola dos) 

si 
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BookWeb.sln (solutia care va contine proiectul Web -si aplicatia SmartClient) 

 
In acest director vom avea: 

BookData( fisierele mdb, scripturile de creeare sql express) 
BookObjects( proiectul de conectare la BD si de obiecte) 
BookWin( proiectul de Windows) 

BookDos ( proiectul de DOS) 
BookWeb(proiectul Web) 

BookDeployWeb(proiectul de deployment Web) 
BookDeployWin(proiectul de deployment Windows) 
BookDeploySmartClient(unde vom face deployment-ul SmartClient) 

BookTest  
Bun - acum haideti sa facem primul pas - creearea bazei de date Access.  

 
Haideti sa creeam impreuna MDB-ul. 
Pornim Acces - cream o noua baza de date - o salvam in BookData. 

O sa va arat cum se creeaza prima tabela: 
Cind sunteti pe tabul "Tables" apasati pe "New Table" 

 
Alegeti "Design View"  
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 Si incepeti sa introduceti valorile prezentate 

 
Pentru a face IDAuthor Primary Key - dati click dreapta pe coloana de dinainte de IDAuthor si 

click pe "Primary Key" 
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La fel se creeaza si celelalte tabele.  

Acum ar trebui sa le legam intre ele. 
Pentru aceasta , accesati Tools=> Relationships 

Adaugati tabelele  

 
Trageti , de pilda, de la IDBook de la tabela Book la IDBook de la tabela Author_Book  
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Aveti grija sa selectati "referential entigrity" - cascade delete si update 

 

 
 
Acum avem Baza de date.Il puteti downloada de aici: book.mdb 

 
Haideti sa concepem obiectele.Acestea or sa fie ca in prima prezentare: 

<a 
href="http://serviciipeweb.ro/iafblog/2006/08/10/Programarea+In+NET+Partea+1.aspx">Progra
marea In NET - Partea 1 </a> 

 
In a treia parte o sa scriem cod pentru accesul la Baza de date, precum si obiectele principale 

pentru acest proiect. 
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programarea in .NET - partea a 3-a - codul pentru obiecte  

Acum la creearea obiectelor  

Fiecare obiect trebuie sa aiba proprietati care corespund cimpurilor din Baza de date si , pentru 
usurinta, alte proprietati/metode  

O sa scriu codul pentru Publisher si o sa las pe celelalte ca un exercitiu pentru dvoastra. Pentru a 

salva/sterge/creea un obiect de tip Publisher o sa implementam corespondentele metode 
corresponding method update / delete / insert.  

Faptul ca un publisher trebuie sa aiba un nume unic o sa il scriem mai tirziu.  

Stim deja ca trebuie sa avem doua baze de date, asa incit o sa avem doua stringuri de conexiune -

pentru Access si pentru SQL Server) 

Pentru a usura scrierea stringurilor de conexiune, va rog sa consultati 
www.connectionstrings.com 

PEntru a vedea toate inregistrarile din tabela publisher, trebuie sa stocam undeva multimea lor. 
Aceasta multime va fi o clasa numita ColPublisher. Ea va contine o metoda numita Load care va 

incarca Publisher-ul din baza de date si le va stoca intr-o colectie. 

Acum , cind stim ce avem de facut in continuare, hai sa scriem ceva cod  

Start Visual C# Express( daca e prima oara cind il lansati, va va intreba setarile -puneti pe cele de 
C#)si creati un nou proiect numit Books  
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si salvati in C:\book 

De obicei, the System.Data.dll este listat in referinte. Daca nu, va rog sa il adaugati. Oricum, 

adaugati va rog si o referinta la System.Configuration.  

Click dreapta pe Solution Explorer si Add reference laOleDBConnection ca mai jos : 

Redenumiti Class1.cs dinproprietati( click pe fisier in Solution Explorer si apasati F4) in 
Publisher.cs 

Daca raspundeti "yes" la urmatoarea intrebare, numele clasei va fi schimbat din Class1 in 

Publisher – si faceti-o public class  

Acum o sa scriem proprietatile de baza pentru un Publisher :  

using System;  

using System.Collections.Generic;  

using System.Text;  

namespace BookObjects  

{  
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public class Publisher  

{  

#region Database properties  

private int m_IDPublisher;  

public int IDPublisher  

{  

get  

{  

return m_IDPublisher;  

}  

set  

{  

m_IDPublisher = value;  

}  

}  

private string m_Name;  

public string Name  

{  

get  

{  

return m_Name;  

}  

set  

{  

m_Name = value;  

}  
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}  

private string m_Site;  

public string Site  

{  

get  

{  

return m_Site;  

}  

set  

{  

m_Site = value;  

}  

}  

#endregion  

}  

}  

Trebuie sa le incarcam aceste proprietati din Baza de date, asa incit o sa scriem o metoda Fill:  

O sa o scriem astfel incit sa nu avem dependenta de BD: 

#region Database methods  

public void FillObject(System.Data.IDataReader idr)  

{  

this.Name = idr["NamePublisher"].ToString();  

this.Site = idr["SitePublisher"].ToString();  

}  

#endregion  
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ACum va trebui sa scriem codul de incarcare din BD a diverselor inregistrari. Asaugati o noua 

clasa ( Project => Add Class) si denumiti-o ColPublisher.cs. 

Din nou , faceti-o public class si haide sa scriem metoda care incarca datele din BD.  

public void Load()  

{  

}  

Cum ne dam seama ca ne trebuie cele doua conexiuni - si o metoda de a vedea pe care din ele le 
incarcam. 

Asa incit vom incepe sa scriem cod spre a incarca conexiunile : 

public static string ConnectionStringMDB  

{  

get  

{  

return System.Configuration.ConfigurationManager.ConnectionStrings["MDB"];  

}  

}  

public static string ConnectionStringSQLServer  

{  

get  

{  

return 

System.Configuration.ConfigurationManager.ConnectionStrings["SQLServer"];  

}  

}  

Asa cum am tot spus, avem doua stringuri de conexiune.  

A venit timpul sa stim cind incarcam una si cind cealalta in functia Load.  

O sa adaug o noua clasa numita Settings si o sa pun acolo setarile comune  
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O sa adaug o enumerare care o sa imi spuna ce baza de date voi utiliza  

public enum DatabaseUsed  

{  

None,  

MDB,  

SQLServer  

}  

si o sa o citim din fisierul de configurare(App.config sau Web.Config) :  

public static DatabaseUsed TheDatabase  

{  

get  

{  

return Enum.Parse(typeof(DatabaseUsed), 

System.Configuration.ConfigurationManager.AppSettings["DatabaseUsed"];  

}  

}  

Puteti observa ca am pus configurarea in Appsetting . Putem stoca si stringurile de conexiune in 

acelasi loc - dar am vrut sa fim compatibili cu standardul Microsoft.  

Codul poate fi obtinut de aici 

Data viitoare o sa scriem cod pentru a incarca datele din BD si a le pune in colectie.  

De citit: 

Pentru .NET best practices, puteti citi http://www.ssw.com.au/ssw/Standards/default.aspx 

Pentru construirea unui ORM (Object-relational_mapping) cum facem aici, cititi articolul 
urmator de pe Wikipedia (http://en.wikipedia.org/wiki/Object-relational_mapping) si puteti gasi o 

lista de ORM la adresa http://en.wikipedia.org/wiki/List_of_object-relational_mapping_software 
. Cred ca ar trebui sa cititi cel putin unul, de exemplu Nhibernate : 
http://www.hibernate.org/343.html  

Pentru SQL Server exista Data Access Application Blocks 
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http://www.microsoft.com/downloads/details.aspx?familyid=f63d1f0a-9877-4a7b-88ec-
0426b48df275&displaylang=en 

 

Pentru a genera acelasi cod plecind de la tabele dintr-o baza de date, cititi Code Generation 
(http://en.wikipedia.org/wiki/Code_generation) si poate CodeSmith 

(http://www.codesmithtools.com/) 

 Programarea in .NET - partea a 4-a : .NET programming  

Recapitulare: Acum avem baza de date Access in C:\Book\BookData – si dll-ul de incarcat 

datele se gaseste in folder-ul C:\Book\BookObjects. 

Vom crea un proiect Windows Forms ca sa vedem datele care sunt in fisierul MDB . 

Dati click cu dreapta pe solutie -si alegeti : Add => New Project => si selectati Windows 

Application. Scrieti numele BookWin. O forma noua va fi creata pentru voi.  

Schimbati numele din Form1 in  frmPublisherList.cs, dati dublu click pe fisier, apasati F4 ca 

sa aduceti fereastra de Properties in fata si schimbati Text din Form1 in List of Publishers.  

Acum trebuie sa spunem proiectului windows sa utilizeze proiectul cu obiecte pe care l-am 

creat mai devreme.Dati click cu dreapta pe proiectul BookWin in So lution Explorer, click 

„Add reference” si dati click pe tab-ul Projects in urmatoarea fereastra.Dublu click pe 

BookObjects project.Compilati apasaind CTRL+SHIFT+B.  

Trebuie sa gasim o cale sa copiem fisierul MDB in aceeasi locatie ca executabilul - in ideea ca 

asa o sa functioneze proiectul si daca aplicata va fi instalata de catre user si in alte locatii . 

(Nu orice user va fi de acord sa instaleze aplicatia in  C:\Book ). 

Solutia este sa facem copierea fisierului MDB de fiecare data dupa ce s-a facut un build - si 

operatia de fie automatizata. 

Dati click dreapta pe proiectul BookWin din Solution Explorer, alegeti properties (sau le 

gasitit in meniul Project => Book Project Properties) 

Pe tab-ul “build events“ aveti  "pre" si  "post" evenimente de build : 
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Vom scrie acest cod in evenimentul de post: 

copy $(ProjectDir)..\BookData\*.mdb $(TargetDir) 

Asta inseamna sa copieze toate fisierele MDB(*.mdb) din C:\Book\BookData (obtinut din 

folder-ul proiectului (C:\Book\BookObjects\), apoi un folder mai sus (.. C:\Book\), apoi catre 

BookData (C:\Book\BookData)) in TargetDir (adica acolo unde se gaseste executabilul - nu 

conteaza daca suntem pe debug sau release.) 

Salvati(CTRL+S) si compilati (CTRL + SHIFT + B) 

Acum in C:\Book\BookObjects\bin\Release sau in  C:\Book\BookObjects\bin\Debug trebuie 

sa fie inca o copie a fisierului MDB. 

Pina aici e OK - haideti sa scriem stringul de conectare la MDB. Click cu dreaptape BookWin 

in Solution Explorer – click Add => New Item => si alegeti “Application Configuration File” 

( nume default :App.config – nu il schimbati !) si sa scriem urmatoarele linii: 

 

<?xml version="1.0" encoding="utf-8" ?> 

<configuration> 

<appSettings> 

<add key="DatabaseUsed" value="MDB"/> 

<!-- possible values : MDB, SQLServer--> 

</appSettings> 

<connectionStrings> 

<add name="MDB" connectionString="Provider=Microsoft.Jet.OLEDB.4.0;Data 

Source=|DataDirectory|\book.mdb;User Id=admin;Password=;"/> 

<!-- TODO : add for asp.net application the connection string with SQL Server-

-> 

</connectionStrings> 

</configuration> 
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De ce am pus DataDirectory ? Daca aplicatia este de tip ClickOnce( mai multe date mai tirziu), 

atunci fisierele de date sunt puse in alta locatie decit executabilul.Acest datadirectory se va 

interpreta ca automat la folder-ul respectiv.  

Acum este momentul sa incarcam datele - mai intii sa facem legatura la baza de date. Vom 

pune cod in fisierul settings.cs ca sa putem schimba conexiune dupa fisierul config la rulare : 

public static DbConnection TheConnection 

{ 

get 

{ 

switch (TheDatabase) 

{ 

case DatabaseUsed.MDB: 

OleDbConnection oc = new OleDbConnection(ConnectionStringMDB); 

return oc;  

case DatabaseUsed.SQLServer: 

SqlConnection sc=new SqlConnection(ConnectionStringSQLServer); 

return sc; 

default: 

// Maybe throw an error that config file has not been initialized with 

// the database type ? 

return null; 

} 

} 

} 
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Dupa cum vedeti , intoarcem un DbConnection indiferent daca este ne conectam la Access sau SQL 

Server. 

Si acum sa scriem cod generic de incarcat datele  

public static IDataReader Load(string CommandLine, DbConnection dbcon) 

{ 

  

if (!(dbcon.State == ConnectionState.Open)) 

dbcon.Open(); 

  

DbCommand dc = null; 

switch (TheDatabase) 

{ 

case DatabaseUsed.MDB: 

dc = new OleDbCommand(CommandLine); 

break; 

case DatabaseUsed.SQLServer: 

dc = new SqlCommand(CommandLine); 

break; 

default: 

//TODO : throw specific error that database type does not properly have been 

initialized 

break; 

} 

dc.CommandType = CommandType.Text; 

dc.Connection = dbcon; 

return dc.ExecuteReader(); 
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return null; 

  

  

} 

  

  

Sa incarcam datele in clasa colectie, ColPublisher : 

using System; 

using System.Collections.Generic; 

using System.Text; 

using System.Data; 

using System.Data.Common; 

  

namespace BookObjects 

{ 

public class ColPublisher : 

System.Collections.ObjectModel.KeyedCollection<string,Publisher> 

{ 

protected override string GetKeyForItem(Publisher item) 

{ 

return "K" + item.IDPublisher; 

} 

public void Load() 

{ 

DbConnection db = Settings.TheConnection; 
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using (db) 

{ 

db.Open(); 

IDataReader ir = Settings.Load("select IDPublisher, NamePublisher, 

SitePublisher from Publisher", db); 

while (ir.Read()) 

{ 

Publisher p = new Publisher(); 

p.FillObject(ir); 

//TODO : add p into the collection 

} 

} 

} 

  

} 

} 

 Acum  ne dam seama ca nu am scris ColPublisher ca si o colectie unde putem sa 

adaugam/stergem/identifica un Publisher. Din fericire, .NET  are destule colectii ajutatoare. 

Sunt 3 namespace-uri mari care contin colectii :System.Collections , System.Collections.ObjectModel 

si System.Collections.Specialized. Veti gasi mult mai mult pe Internet( de exemplu o implementare an 

implementation of a Set collection : http://www.codeproject.com/csharp/sets.asp) 

Vom allege pentru ColPublisher clasa 

System.Collections.ObjectModel.KeyedCollection<string,Publisher> .O sa 

trebuiasca sa scriem cum se obtine o cheie unica(identificator unic) pentru un specific Publisher –si 

ce e o mai buna alegere decit ID ? 

protected override string GetKeyForItem(Publisher item) 

{ 
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return "K" + item.IDPublisher; 

} 

  

Acum putem scrie metoda Load: 

using System; 

using System.Collections.Generic; 

using System.Text; 

using System.Data; 

using System.Data.Common; 

  

namespace BookObjects 

{ 

public class ColPublisher : 

System.Collections.ObjectModel.KeyedCollection<string,Publisher> 

{ 

protected override string GetKeyForItem(Publisher item) 

{ 

return "K" + item.IDPublisher; 

} 

public void Load() 

{ 

DbConnection db = Settings.TheConnection; 

using (db) 

{ 

db.Open(); 

IDataReader ir = Settings.Load("select IDPublisher, NamePublisher, 

SitePublisher from Publisher", db); 
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while (ir.Read()) 

{ 

Publisher p = new Publisher(); 

p.FillObject(ir); 

this.Add(p); 

} 

} 

} 

  

} 

} 

  

Sa vedem cum o folosim din form: 

Faceti dublu click pe frmPublisherList.cs si trageti un DataGridView pe forma 
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Sa configuram acum data source: 
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Click pe “(none)” si selectati “add new data source” 

In dialogul urmator  alegeti “Object”  
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si apasati next  

Acum mariti nodul BookObjects  si alegeti “ColPublisher”. Apasati Next si apoi Finish. 

Pe forma a aparut un nou control numit colPublisherBindingSource -“ si Grid-ul are deja coloanele 

definite. 

Acum sa scriem codul pentru a incarca datele din Baza de date: 

Dublu click pe forma si o sa va gasiti editind evenimentul Form_Load: 

private void frmPublisherList_Load(object sender, EventArgs e) 

{ 

BookObjects.ColPublisher publishers = new BookObjects.ColPublisher(); 

publishers.Load(); 

colPublisherBindingSource.DataSource = publishers; 

} 

  

Sa setam solutia sa porneasca cu BookWin -“ click dreapta pe BookWin -“ si selectati “Set as startup 

project” 

Acum apati F5 si asteptati sa vedeti rezultatele. Daca totul e OK, veti vedea  forma fara nici un fel de date 

-  si e foarte correct din cauza ca nu am introdus nici un fel de Publisher-i in Book.mdb 

 In urmatoarea lectie vom scrie cod ca sa inseram un nou publisher si sa il vedem in lista 

  

Lecturi optionale: 

CSLA : http://www.lhotka.net/cslanet/ -“ un framework bun pentru a se folosi pentru securitate, 

scalabilitate, binding si multe altele(si, mai ales, free si cu cod sursa). 
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Programarea in .NET - partea a 5a -editarea de obiecte  

Va trebui, asa cum am promis, sa facem adaugarea/ modificarea / stergerea de obiecte( pe scurt, 
C(R)UD – create, (read), update, delete). Luam un buton din Toolbox, il tragem pe forma, ii 
setam din proprietati ( apasati F4) numele la btnAdd si text la “&Add” ( &A e pentru ca, atunci 
cind apasam <ALT> + A , sa fie ca si cind dam click pe button) 

Acum dati dublu click pe button – si veti intra in codul de click. Avem o problema : trebuie ca 
user-ul sa introduca numele Publisher-ului. O sa creeam o noua forma : Click dreapta pe 
BookWin, Add => Windows Form- si ii veti da denumirea de frmPublisherAdd.cs. Apasati F4 si 

la Text puneti : Add Publisher 

Adaugati un Label( Name: lblName , Text : &Name) si un textbox ( Name : txtName) 

Adaugam acum un Button de Add ( Name : btnAdd, Text : &Add) si unul de Exit (Name : 
btnExit, Text : E&xit) 

  

Codul de pe btnExit e cel mai usor ( dati dublu click pe buton) 

  private void btnExit_Click(object sender, EventArgs e) 

        { 

            this.Close();//close the form 

        } 

Codul de pe Button-ul de Add : 

  

            private void btnAdd_Click(object sender, EventArgs e) 

        { 

            BookObjects.Publisher p = new BookObjects.Publisher(); 

            p.Name = txtName.Text; 

            p.Save(); 

this.Close();//close the form 
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        } 

  

E clar ca trebuie sa scriem metoda de Save pe Publisher 

Inapoi la clase : si acolo vom scrie metoda de save. 

  public void Save() 

        { 

            string strSQL = " insert into Publisher(NamePublisher"; 

            if (!string.IsNullOrEmpty(this.Site)) 

                strSQL += ",SitePublisher "; 

  

            strSQL += " ) Values ("; 

  

            strSQL += "'" + this.Name.Replace("'","''") + "'";//terminator for 

string in SQL is ' - so replace with '' 

             

            if (!string.IsNullOrEmpty(this.Site)) 

                strSQL += "," +"'"+ this.Site.Replace("'", "''") 

+"'";//terminator for string in SQL is ' - so replace with '' 

  

  

            strSQL += " )"; 

  

             

            Settings.ExecuteSQL(strSQL); 
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        } 

  

In sfirsit, sa scriem codul pentru adaugare de pe forma de list: 

E clar ca va trebui sa facem re incarcarea datelor  - deci o sa luam codul de 

pe frmPublisherList_Load si o sa il punem in o functie generica , RebindData()  

  

private void btnAdd_Click(object sender, EventArgs e) 

        { 

            frmPublisherAdd f = new frmPublisherAdd(); 

            f.ShowDialog(this); 

            RebindData(); 

        } 

  

private void RebindData() 

        { 

BookObjects.ColPublisher publishers = new 

BookObjects.ColPublisher(); 

            publishers.Load(); 

            colPublisherBindingSource.DataSource = publishers; 

        } 

  

Sa verificam functionarea 

Dati CTRL+ F5 , apasati Add – introduceti un nume – apasati Add – si 

verificati ca se vede in lista ceea ce ati introdus. 

  

Sa facem acum stergerea. 

Adaugati alt buton(Name = btnDelete, Text = &Delete) si sa scriem cod pentru 

delete 
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private void btnDelete_Click(object sender, EventArgs e) 

        { 

  

            BookObjects.Publisher p = colPublisherBindingSource.Current as 

BookObjects.Publisher; 

            if (p != null) 

            { 

                //avert the user 

                if (MessageBox.Show(this, "Delete " + p.Name, "Delete", 

MessageBoxButtons.YesNo, MessageBoxIcon.Question) == DialogResult.No) 

                    return; 

  

  

                p.Delete(); 

                RebindData(); 

            } 

        } 

  

In sfirsit, sa scriem codul pentru update: iarasi buton, iarasi cod 

private void btnUpdate_Click(object sender, EventArgs e) 

        { 

            BookObjects.Publisher p = colPublisherBindingSource.Current as 

BookObjects.Publisher; 

  

            if (p == null) 

                return; 
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            frmPublisherUpdate f = new frmPublisherUpdate(p); 

            f.ShowDialog(this); 

            RebindData(); 

        } 

  

Pentru asta, adaugam o alta forma, in care sa facem update . 

Dar avem neaparata nevoie de un publisher pe care sa facem update.Vom modifica 

constructorul formei ca sa accepte ca parametru de intrare un publisher. 

  

Ca sa punem valorile deja obtinute in text box-uri, avem 2 variante : 

Fie codam de mina de doua ori ( ceva de genul  txtName.Text= m_Publisher.Name 

si , pe salvare, m_Publisher.Name= txtName.Text),fie lucram cu DataBindings 

direct . Prefer acum, pentru rapiditate, a doua varianta : 

  

public partial class frmPublisherUpdate : Form 

    { 

        private BookObjects.Publisher m_Publisher; 

        public frmPublisherUpdate(BookObjects.Publisher pub) 

        { 

            m_Publisher = pub; 

            InitializeComponent();             

        } 

  

         

        private void frmPublisherUpdate_Load(object sender, EventArgs e) 

        { 

            txtName.DataBindings.Add("Text", m_Publisher, "Name"); 
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            txtSite.DataBindings.Add("Text", m_Publisher, "Site"); 

        } 

  

        private void btnSave_Click(object sender, EventArgs e) 

        { 

            m_Publisher.Update(); 

            this.Close(); 

        } 

  

        private void btnExit_Click(object sender, EventArgs e) 

        { 

            this.Close(); 

        } 

  

  

    } 

  

Sa scriem si codul de salvare pe publisher : 

  public void Update() 

        { 

            string strSQL = " update Publisher set "; 

            strSQL += " NamePublisher = "; 

  

            strSQL += "'" + this.Name.Replace("'", "''") + "'"; 

  

            strSQL += ","; 
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            strSQL += " SitePublisher = "; 

  

            strSQL += "'" + this.Site.Replace("'", "''") + "'"; 

  

  

            strSQL += " where IDPublisher = " + 

this.IDPublisher;                             

            strSQL += " "; 

  

  

            Settings.ExecuteSQL(strSQL); 

        } 

  

  

Ca tema de acasa, ramine sa faceti acelasi lucru pentru tabela Author. 

Data viitoare o sa facem un mic refactoring de code... si o sa facem un 

program de setup pentru aplicatia Windows. 

  

             

Programarea in .NET - partea a 6-a - setup program  

Setup-ul este proiectul prin care creeam un kit de instalare – presupunem ca vrem sa scriem un CD cu 

aplicatia(dll, exe, BD, alte setari). 

 Click dreapta pe BookWin, alegeti “properties” si click pe tab-ul de “Publish” 

Acolo gasiti “Publishing location” -“ valoare implicita fiind http://localhost/BookWin/ 
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Daca nu aveti IIS, atunci puteti alege si o cale fizica, de exemplu : C:\Book\BookSetup\ 

Problema de rezolvat : printre fisierele care trebuie instalate se afla si fisierul mdb. 

Daca aveti VS.NET Standard(sau ceva mai mult) aveti un proiect special care va ingaduie sa adaugati alte 

fisiere la proiectul de instalare. Pentru moment ne jucam cu ce avem. Asa ca faceti click dreapta pe 

proiectul Bookwin, click add=>existing item si cautati  book.mdb file din C:\Book\BookData . 

Compilati proiectul (CTRL+Shift+B) si veti gasi acum book.mdb on intre fisierele aplicatiei – ca fisier de 

date. 

Acum conditiile de instalare : Pentru ca facem instalarea de pe un CD, e mai bine sa includem si kitul de 

.NET 2.0 –ca sa facem download tot de pe CD(cind facem instalarea de pe Internet, e preferabil sa facem 

instalarea .NET 2.0 de la site-ul MS) 

 

Update-urile automane nu sunt inca valabile, din cauza ca nu avem inca un WebSite. Dar putem modifica 

citeva dintre Options, ca “publisher name”,”product name” si altele. 
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Acum sa apasam pe Publish Wizard : 

            Primul pas ne intreaba un sa creeam kit-ul de instalare (C:\Book\BookSetup\deja selectat) , 

urmatorul sa ne intrebe suportul fizic (click “from cd -“rom or dvd rom”). 

            Al treilea pas ne ingaduie sa setam unde va cauta aplicatia update-urile – dar, asa cum am spus nu 

avem inca un WebSite asa ca selectati “the application will not check for updates” 

            Si apasati finish! 

  

Daca vreo eroare se intimpla spunind “can not find package”, mergeti la Microsoft .NET Framework 

Version 2.0 Redistributable Package (x86) 

http://www.microsoft.com/downloads/details.aspx?FamilyID=0856eacb-4362-4b0d-8edd-

aab15c5e04f5&displaylang=en  si downloadati kit-ul. Copiati-l in <C:\Program Files>\Microsoft Visual 

Studio 8\SDK\v2.0\Bootstrapper\Packages\DotNetFX 

Pentru instmsia.exe , duceti-va la http://go.microsoft.com/fwlink/?LinkId=37285   

  

Acum puteti scrie folder-ul  C:\Book\BookSetup pe un CD si sa testati instalarea. 

Daca nu vreti sa irositi un CD, puteti scrie folder-ul intr-un fisier .iso si sa il incarcati ca un CD. 

O metoda de a creea un fisier ISO este Alex Feinman IsoRecorder 

http://isorecorder.alexfeinman.com/isorecorder.htm  

Faceti download ( eu am testat versiunea pentru XP SP2 ) si click dreapta pe folder-ul Book Setup 
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In meniu vedeti “Create ISO image file “ click si acceptati  setarile existente. 

Acum aveti un CD  -si puteti incarca acest CD cu Virtual CD Control Panel. 

  

Puteti testa acum programul de pe CD-ul incarcat. 

Mai mult,daca vreti sa il testati pe alta versiune de Windows(pentru care aveti kit-ul de instalare) puteti 

face download la Virtual PC 2004 SP1 or VMWare si sa creati cu aceasta un nou Windows (repet : trebuie 

sa aveti CD-urile de instalare a Windows!). 

mailto:ignatandrei@yahoo.com?subject=Tutorial%20programare%20in%20.NET%20
http://www.serviciipeweb.ro/iafblog


Tutorial programare in .NET   Ignat Andrei 

http://www.serviciipeweb.ro/iafblog Page 35 
 

  

Data viitoare o sa facem o aplicatie ASP.NET cu o baza de date SQL Server. 

Lecturi recomandate: 

            Comparatie intre versiunile de VS.NET 2005: 

http://msdn.microsoft.com/vstudio/products/compare/default.aspx 

            Virtual PC 2004 SP1 (free) 

http://www.microsoft.com/downloads/details.aspx?familyid=6d58729d-dfa8-40bf-afaf-

20bcb7f01cd1&displaylang=en 

            Probleme de instalare : 

http://forums.microsoft.com/MSDN/ShowPost.aspx?PostID=13937&SiteID=1 

            Virtual CD Control Panel -“  http://download.microsoft.com/download/7/b/6/7b6abd84-7841-

4978-96f5-bd58df02efa2/winxpvirtualcdcontrolpanel_21.exe 

            Alex Feinman -“ Make ISO http://isorecorder.alexfeinman.com/isorecorder.htm 

Programarea in .NET - partea a 7-a : ASP.NET application  

Acum e cazul sa facem o aplicatie ASP.NET. Presupun ca ati instalat deja Internet Information Services 

(daca il aveti, gasiti un shortcut in folder-ul Administrative tools) .Daca nu , va rog sa il instalati de pe CD-

ul cu Windows si sa rulati aspnet_regiis.exe pe care o sa il gasiti in <WindowsPath> 

\Microsoft.NET\Framework\<latest version> (my path is 

C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727) 

Instalati SQL Server Express(<Address>) si WebDeveloper(<Adress>) –acesta fara instalare de SQL pentru 

ca deja ati facut-o. 

 Acum e timpul sa importam datele noastre in baza de date SQL Server. Porniti SQL Server Management 

Studio si o sa gasiti citeva baze de date deja instalate.Creati una noua ( nume : Book) si importati mdb-ul 

in aceasta noua baza de date. Click dreapta pe baza de date Book => Tasks= > Import data .  

In primul ecran alegeti ca sursa de date Microsoft Access 
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Urmatorul ecran e configurat OK – dupa cum vedeti utilizeaza windows authentication. 

Alegeti apoi “Copy data from one or more table or views” si click “select all” in urmatorul ecran. 

Puteti acum apasa “Finish” si sa asteptati terminarea operatiei. 

  

Acum citeva modificari ale structurii se impun pentru a nu avea probleme de concurenta la creearea 

simultana a doi Publisher-i : 
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Alegeti Book=> Tables in SQL Server Management Studio. Click dreapta tabela Publisher si apasati 

“modify”. 

Vom face IDPublisher un “auto number” ca in Access. In SQL Server, “auto number” se numeste 

“identity”. 

 

mailto:ignatandrei@yahoo.com?subject=Tutorial%20programare%20in%20.NET%20
http://www.serviciipeweb.ro/iafblog


Tutorial programare in .NET   Ignat Andrei 

http://www.serviciipeweb.ro/iafblog Page 38 
 

  

Imediat ce modificati  proprietatea (Is Identity), veti vedea “identity increment” si  “seed “ fiind 

modificate in 1 si 1( adica creste cu 1(increment) pornind de la 1(seed)). 

Salvati tabela. 

Urmatorul pas este sa creeam un folder in care sa creeam program-ul internet. 

Duceti-va la  C:\Book si creati un nou folder , numit BookWeb 

Acum din folder-ul  Administrative Tools faceti dublu click pe Internet Information Services si mariti (local 

computer)=> WebSites=> Default Web Site.Click dreapta pe Default Web Site si alegeti New => Virtual 

Directory. Apasati pe next. In “Alias” introduceti numele BookWeb. Pentru folder alegeti 

C:\Book\BookWeb .Apasati de doua ori “Finish” si suntem gata sa incepem. 

  

Acum suntem gata sa incepem prima noastra pagina in ASP.NET. 

Ca si in proiectul Windows vom avea o pagina de lista si paginile de creere/modificare/stergere pentru 

Publisher.Ca sa facem ca site-ul sa aiba aceeasi infatisare, vom crea  o pagina “master” numita -

“Book.master”. 

Deschideti Microsoft Visual Web Developer 2005 Express Edition si alegeti “Open Web Site” ca in 

imagine: 

 

  

Alegeti tabul “Local IIS” si “BookWeb” ca “virtual directory” 
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In “Solution Explorer” click dreapta pe http://localhost/BookWeb si alegeti “Add new Item “ si alegeti 
Master Page si numiti “Book.master”.Nu uitati sa selectati”Place code in separate file”     

 

  

Vom face interfata grafica a master page mai degraba simpla, lasind cititorului sarcina de a  o 

infrumuseta  : pune o tabela care area 2 rinduri si 2 coloane , rindul de sus fiind format dintr-o singura 

celula 

 Codul este urmatorul: 

<%@ Master Language="C#" AutoEventWireup="true" CodeFile="Book.master.cs" 

Inherits="Book" %> 

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN" 

"http://www.w3.org/TR/xhtml1/DTD/xhtml1-transitional.dtd"> 

<html xmlns="http://www.w3.org/1999/xhtml"> 

<head runat="server"> 

    <title>Untitled Page</title> 
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</head> 

<body> 

    <form id="form1" runat="server"> 

        <div> 

            <table width="100%"> 

                <tr> 

                    <td colspan="2" align="center"> 

                        Book application</td> 

                </tr> 

                <tr> 

                    <td width="10%"> 

                        Right menu 

                    </td> 

                    <td> 

                        <asp:ContentPlaceHolder ID="ContentPlaceHolder1" 

runat="server"> 

                        </asp:ContentPlaceHolder> 

                    </td> 

                </tr> 

            </table> 

        </div> 

    </form> 

</body> 

</html> 
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Acum sa creeam pagina de listare de publisher. Adaugati un nou item -“ Web 

Form(frmPublisherList.aspx) -“ si verificati ca ati check-uit amindoua check-urile.Urmatorea fereasta va 

arata BookMaster pe care trebuie sa il selectati si apoi sa apasati OK.Click dreapta pe fisier si alegeti “Set 

as start page” 

In asp:content trageti un gridview (il gasiti in Toolbox=> Data) . 

Acest grid trebuie umplut cu date – asa ca trebuie sa ne conectam la obiectele create(la fel ca la aplicatia 

Windows).Aceasta e problema –cum putem sa ne conectam fie la versiunea de Release sau debug a 

proiectului daca nu il avem in solutie, asa cum era la Windows Forms ?Solutia este  indirectia(destul de 

intilnita in programare) : facem un nou folder, bookdll si o sa copiem acolo obiectele, indiferent daca e 

debug sau release.Din acest nou folder o sa isi ia obiecteleaplicatia Web. 

Creati folder-ul C:\Book\BookDll , mergeti inapoi la solutia Book.sln si la Build puneti aceasta linie in 

“Post build command line”: 

copy $(TargetDir)*.*  $(ProjectDir)..\BookDll /Y 

Compilati proiectul .O sa gasiti in folder-ul C:\Book\BookDll fisierul BookObjects.dll 

Adaugati referinta la BookObjects.dll aplicatiei BookWeb ( ca de obicei: click dreapta pe proiectul 

http://localhost/BookWeb, alegeti add reference, click pe tab-ul Browse si mergeti in folder-ul 

C:\Book\BookDll. 

  

Pe  frmPublisherList.aspx apasati F7 si puneti urmatoarele linii in evenimentul Page_load  

if (!IsPostBack) 

            BindData(); 

  

Functia BindData arata la fel ca cea de pe Windows Forms: 

private void BindData() 

    { 
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        BookObjects.ColPublisher publishers = new BookObjects.ColPublisher(); 

        publishers.Load(); 

        grdPublisher.DataSource = publishers; 

        grdPublisher.DataBind();// main difference ASP si Windows forms - this 

call 

    } 

  

  

Acum, daca rulati proiectul, o eroare o sa se intimple : Object 
reference not set to an instance of an object 

Cauza este ca nu am adaugat un fisier web.config care sa contina(asemanator app.config) conexiunea la 

baza de date.Adaugati un fisier nou de tipul “web configuration file” ,acceptati numele  ales de 

Web.Config si puneti urmatoarele linii in connection strings: 

<connectionStrings> 

    <add name="SQLServer" 

connectionString="server=.;Trusted_Connection=true;database=Book;"/> 

  </connectionStrings> 

Va trebuie sa specificam ca ne conectam la SQL Server. 

<appSettings> 

    <add key="DatabaseUsed" value="SQLServer"/> 

    <!-- possible values : MDB, SQLServer--> 

  </appSettings> 

  

  

Apasati din nou CTRL+F5.  Eroarea aparuta acum este :  
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Cannot open database "Book" requested by 

the login. The login failed. 
Login failed for user '<PCNAME>\ASPNET'. 

De ce aceasta eroare ? In connection strings am pus Trusted_Connection=true 

in web.config. Asa incit utilizatorul care se conecteaza este cel sub care 

ruleaza site-ul(<PCNAME>/ASPNET). 

Avem mai multe solutii : 

1)      Sa punem in web.config o conexiune care sa foloseasca 

autentificarea cu user name si password (de obicei buna pentru site-

urile Internet) 

2)      Sa punem site-ul sa ruleze sub alt user- unul care sa aiba drepturi 

de conectare la Baza de date sites) -“ vezi imaginea 

3)      Sa punem utilizatorii sa se autentifice la conectare si sa dam 

drepturi lor sa se conecteze – utilizand “Integrated windows”  

impreuna cu o setare in fisierul web.config  <identity 

impersonate="true"/>(bun pentru site-uri intranet) 

4)      Sa  cream un utilizator SQL Server pentru (IUSR_ )care sa aiba 

drepturi pe baza de date. 

Puteti sa va faceti alegerea - personal, prefer prima solutie. 

OK.Data viitoare vom vedea cum sa inseram date in baza de date Sql Server.  
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Lecturi recomandate 

Master Pages 

ConnectionStrings 

 Programarea in .NET - partea a 8-a - editarea in ASP.NET  
  

Acum vom edita in cadrul proiectului Web obiectele Publisher. 

Adaugati un nou WebForm , numiti-o frmPublisher_Insert.aspx si asigurati-va ca “Place code in 
separate file” si “Select master page” sunt amindoua selectate. 
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Scimbati in „source view” titlul de la “Untitled Page” la “Insert Publisher” 

Acum trebuie sa punem controalele pentru inserare, adica numele  si site-ul Publisher-ului. 

Prefer sa pun o tabela(desi altii prefera CSS) si codul paginii o sa arate asa : 

  

<%@ Page Language="C#" MasterPageFile="~/Book.master" AutoEventWireup="true" 

CodeFile="frmPublisher_Insert.aspx.cs" Inherits="frmPublisher_Insert" 

Title="Insert Publisher" %> 

<asp:Content ID="Content1" ContentPlaceHolderID="ContentPlaceHolder1" 

Runat="Server"> 

    <table> 

        <tr> 

            <td colspan="2">Enter values 

            </td> 

        </tr> 

        <tr> 

            <td> 

               Name  

            </td> 

            <td> 

                <asp:TextBox ID="txtName" runat="server"> 

                </asp:TextBox> 

            </td> 

        </tr> 

        <tr> 

            <td> 

               Site 

            </td> 
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            <td> 

                <asp:TextBox ID="txtSite" runat="server"> 

                </asp:TextBox> 

            </td> 

        </tr> 

        <tr> 

            <td><asp:Button ID="btnSave" Text="Insert" runat="server" /> 

            </td> 

            <td><asp:Button ID="btnCancel" Text="Cancel" runat="server" /> 

            </td> 

        </tr> 

    </table> 

</asp:Content> 

  

Acum faceti click pe „design view” si faceti click dublu pe butonul „Insert” ca sa generati 

evenimentul de Click. Iarasi Click dublu in „solution explorer” pe  frmPublisher_Insert.aspx si , 
in Design view, click dublu pe butonul Cancel . 

Pentru „Cancel” e clar ce trebuie facut– redirectionata pagina la frmPublisherList.aspx  

Response.Redirect("frmPublisherList.aspx", false); 

Pentru buton-ul de „save” va trebui sa creeam un nou „publisher” si sa il salvam : 

  Publisher p = new Publisher(); 

        p.Name = txtName.Text; 

        p.Site = txtSite.Text; 

        p.Insert(); 

        Response.Redirect("frmPublisherList.aspx", false); 

Sa incercam codul setind frmPublisher_Insert.aspx ca „start page” si sa rulam proiectul (F5) 
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Daca totul a mers bine (fiti sigur ca Insert cheama Save()) o sa vedeti in frmPublisherList.aspx 

exact numele si site-ul publisher-ului creat. 

Este clar ca frmPublisherList.aspx are nevoie de un buton cu ajutorul caruia sa navigam pe 
pagina de creare.Sa il punem: 

<asp:Button ID="btnNew" runat="server" Text="New" OnClick="btnNew_Click" /> 

Si sa scriem codul : 

protected void btnNew_Click(object sender, EventArgs e) 

    { 

        Response.Redirect("frmPublisher_Insert.aspx", false); 

    } 

Atita este de ajund pentru crearea de un nou publisher.  

Pentru editare si stergere se poate folosi chiar grid-ul – dar prefer sa avem doua pagini noi. 

Asa ca o sa adaugam pe grid un link de edit si un buton de delete – asta pentru a vedea codul 

diferit generat de cele doua. 

Pagina arata asa: 

<%@ Page Language="C#" MasterPageFile="~/Book.master" AutoEventWireup="true" 

CodeFile="frmPublisherList.aspx.cs" Inherits="frmPublisherList" 

Title="Publisher Lists" %> 

<asp:Content ID="Content1" ContentPlaceHolderID="ContentPlaceHolder1" 

Runat="Server"> 

    <asp:GridView ID="grdPublisher" runat="server" 

AutoGenerateColumns="false"> 

        <Columns> 

            <asp:BoundField DataField="Site" HeaderText="Site" /> 

            <asp:BoundField DataField="Name" HeaderText="Name" /> 

            <asp:TemplateField HeaderText="Operations"> 

                <ItemTemplate> 

                    <asp:Button runat="server" ID="btnDelete" 

CommandName="deletepub" CommandArgument='<%# Eval("IDPublisher") %>' 

Text="Delete" /> 
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                    <asp:HyperLink runat="server" ID="hkEdit" NavigateUrl='<%# 

Eval("IDPublisher","~/frmPublisher_Edit.aspx?ID={0}") %>' 

Text="Edit"></asp:HyperLink> 

                </ItemTemplate> 

            </asp:TemplateField> 

        </Columns> 

     

    </asp:GridView> 

    <br /> 

    <asp:Button ID="btnNew" runat="server" Text="New" OnClick="btnNew_Click" 

/> 

</asp:Content> 

  

Link hkEdit este clar – redirecteaza pagina la frmPublisher_Edit.aspx cu  ID-ul publisher-

ului de pe rindul respectiv. 

Pentru buton trebuie sa cream evenimentul - si evenimentul este chiar pe grid si se numeste 
RowCommand 

In fisierul .cs: 

    protected void grdPublisher_RowCommand(object sender, 

GridViewCommandEventArgs e) 

    { 

        switch(e.CommandName) 

        { 

            case "deletepub": 

                int idPublisher; 

                if(int.TryParse(e.CommandArgument.ToString(),out idPublisher)) 

                { 

                    Response.Redirect("frmPublisher_Delete.aspx?ID="+ 

idPublisher, false); 
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                    return; 

                } 

                Response.Write("Can not find id:" + idPublisher); 

                break; 

            default: 

                Response.Write("Do not know command : " + e.CommandName); 

                break; 

        } 

    } 

  

Acum sa creeam cele doua pagini noi frmPublisher_Delete si frmPublisher_Edit  . 

La amindoua o sa copiem tabela de la pagina de „new: si sursa –fara definitia de clasa. Un singur 

lucru e de facut : sa regasim obiectul „Publisher” dupa id-ul trimis.Mai intii regasim ID-ul : 

  

  int idPublisher; 

        if(!int.TryParse(Request.QueryString["ID"],out idPublisher)) 

        { 

            Response.Redirect("frmPublisherList.aspx", false); 

            return; 

        } 

        //we have id of the publisher 

  

Cum facem acum regasirea dupa ID ? Amintiti-va ca in aplicatia Windows forms ceea ce am 
trecut de la o forma la alta a fost chiar obiectul. Aici avem doar Id-ul.Va trebui sa adaugam acest 

cod de regasire al obiectului- vom deschide solutia Book.sln si vom adauga metoda respectiva. 

Imi place sa pun metoda pe clasa ColPublisher si sa o fac statica – pentru ca nu depinde de vre-o 
variabila a clasei ColPublisher. 
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public static Publisher sLoadFromID(int ID) 

        { 

            DbConnection db = Settings.TheConnection; 

            using (db) 

            { 

                db.Open(); 

                IDataReader ir = Settings.Load("select IDPublisher, 

NamePublisher, SitePublisher from Publisher where IDPublisher="+ ID, db); 

                while (ir.Read()) 

                { 

                    Publisher p = new Publisher(); 

                    p.FillObject(ir); 

                    return p; 

                } 

            } 

            return null; 

        } 

  

Compilati si inapoi la proiectul Web.Acum putem folosi metoda: 

//we have id of the publisher 

        Publisher p = ColPublisher.sLoadFromID(idPublisher); 

        if (p == null)//maybe someone deleted  

        { 

            Response.Redirect("frmPublisherList.aspx", false); 

            return; 
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        } 

        if (!IsPostBack) 

        { 

            //now fill the text boxes 

            txtName.Text = p.Name; 

            txtSite.Text = p.Site; 

        } 

  

De ce am pus (!IsPostBack ) ? Din cauza ca „textboxes” trebuie sa fie umplute cu numele 

Publisher-ului doar prima oara. Cind user-ul modifica numele si/sau site-ul si dupa ce da click pe 
„save” trebuie sa ii pastram modificarile.  

Pentru a regasi usor obiectul, sa il punem intr-o proprietate: 

private Publisher pub 

    { 

        get 

        { 

            int idPublisher; 

            if (!int.TryParse(Request.QueryString["ID"], out idPublisher)) 

            { 

                 

                return null; 

            } 

            //we have id of the publisher 

            return ColPublisher.sLoadFromID(idPublisher); ; 

             

        } 
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    } 

  

Codul pe  PageLoad va fi acum mai mic: 

protected void Page_Load(object sender, EventArgs e) 

    { 

        Publisher p = pub; 

        if (p == null) 

        { 

            Response.Redirect("frmPublisherList.aspx", false); 

            return; 

        } 

  

        if (!IsPostBack) 

        { 

            //now fill the text boxes 

            txtName.Text = p.Name; 

            txtSite.Text = p.Site; 

        } 

    } 

  

Si va trebui sa modificam si codul de pe „save” : 

protected void btnSave_Click(object sender, EventArgs e) 

    { 

        Publisher p = pub; 

        if (p == null) 
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        { 

            //TODO : throw an exception that someone deleted the publisher 

            Response.Redirect("frmPublisherList.aspx", false); 

            return; 

  

        } 

  

        p.Name = txtName.Text; 

        p.Site = txtSite.Text; 

        p.Update(); 

        Response.Redirect("frmPublisherList.aspx", false); 

    } 

  

  

Va trebui sa modificati si text-ul butonului de la “Insert” la “Save” 

Pe pagina de „delete” o sa punem acelasi cod ca sa regasim „Publisher”-ul .Iata codul: 

using System; 

using System.Data; 

using System.Configuration; 

using System.Collections; 

using System.Web; 

using System.Web.Security; 

using System.Web.UI; 

using System.Web.UI.WebControls; 

using System.Web.UI.WebControls.WebParts; 
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using System.Web.UI.HtmlControls; 

using BookObjects; 

  

public partial class frmPublisher_Delete : System.Web.UI.Page 

{ 

    private Publisher pub 

    { 

        get 

        { 

            int idPublisher; 

            if (!int.TryParse(Request.QueryString["ID"], out idPublisher)) 

            { 

  

                return null; 

            } 

            //we have id of the publisher 

            return ColPublisher.sLoadFromID(idPublisher); ; 

  

        } 

    } 

    protected void Page_Load(object sender, EventArgs e) 

    { 

        Publisher p = pub; 

        if (p == null) 

        { 

            Response.Redirect("frmPublisherList.aspx", false); 
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            return; 

        } 

  

        if (!IsPostBack) 

        { 

            //now fill the text boxes 

            txtName.Text = p.Name; 

            txtSite.Text = p.Site; 

        } 

    } 

    protected void btnSave_Click(object sender, EventArgs e) 

    { 

        Publisher p = pub; 

         

        if(p != null) 

            p.Delete(); 

  

        Response.Redirect("frmPublisherList.aspx", false); 

    } 

    protected void btnCancel_Click(object sender, EventArgs e) 

    { 

        Response.Redirect("frmPublisherList.aspx", false); 

    } 

} 

  

  

mailto:ignatandrei@yahoo.com?subject=Tutorial%20programare%20in%20.NET%20
http://www.serviciipeweb.ro/iafblog


Tutorial programare in .NET   Ignat Andrei 

http://www.serviciipeweb.ro/iafblog Page 56 
 

Nu uitati sa schimbati textul de la  btnSave in “Delete”. Puteti de asemenea sa puneti " 

ReadOnly="true" pe textboxes – ca sa nu dati impresia ca se editeaza ceva.  

<%@ Page Language="C#" MasterPageFile="~/Book.master" AutoEventWireup="true" 

CodeFile="frmPublisher_Delete.aspx.cs" Inherits="frmPublisher_Delete" 

Title="Untitled Page" %> 

<asp:Content ID="Content1" ContentPlaceHolderID="ContentPlaceHolder1" 

Runat="Server"> 

    <table> 

        <tr> 

            <td colspan="2">Enter values 

            </td> 

        </tr> 

        <tr> 

            <td> 

               Name  

            </td> 

            <td> 

                <asp:TextBox ID="txtName" runat="server" ReadOnly="true"> 

                </asp:TextBox> 

            </td> 

        </tr> 

        <tr> 

            <td> 

               Site 

            </td> 

            <td> 

                <asp:TextBox ID="txtSite" runat="server" ReadOnly="true"> 

                </asp:TextBox> 
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            </td> 

        </tr> 

        <tr> 

            <td><asp:Button ID="btnSave" Text="Delete" runat="server" 

OnClick="btnSave_Click" /> 

            </td> 

            <td><asp:Button ID="btnCancel" Text="Cancel" runat="server" 

OnClick="btnCancel_Click" /> 

            </td> 

        </tr> 

    </table> 

</asp:Content> 

  

Programarea in .NET - partea a 9-a -site map si localization  

Sitemap-ul se foloseste pentru ca utilizatorul sa vada oricind „unde” este si unde poate reveni. 
Folosirea lui e relativ usoara: 

Adaugati un nou „item” – gasiti “Site Map” si acceptati numele de Web.sitemap 

Puneti urmatorul cod inauntru :  

<?xml version="1.0" encoding="utf-8" ?> 

<siteMap xmlns="http://schemas.microsoft.com/AspNet/SiteMap-File-1.0" > 

  <siteMapNode url="default.aspx" title="Main"  description="First Page"> 

    <siteMapNode url="frmPublisherList.aspx" title="All publishers"  

description="Publishers list" > 

      <siteMapNode url="frmPublisher_Insert.aspx" title="New Publisher" 

description="Add new"></siteMapNode> 

      <siteMapNode url="frmPublisher_Edit.aspx" title="Edit Publisher" 

description="Edit"></siteMapNode> 

      <siteMapNode url="frmPublisher_Delete.aspx" title="Delete Publisher" 

description="Delete"></siteMapNode> 
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    </siteMapNode> 

    <siteMapNode url="frmBookList.aspx" title="All books"  description="Book 

list" > 

  

    </siteMapNode> 

  </siteMapNode> 

</siteMap> 

  

( Numele sunt destul de descriptive – url, title si description) 

Acum e timpul sa il vedem la lucru: 

Deschideti Book.master( care tine cum arata site-ul in general) , si puneti un control „site map” ( 
il gasiti in tab-ul „navigation” de pe „toolbox”) inainte de „content place holder”: 

<asp:SiteMapPath ID="SiteMapPath1" runat="server" Font-Names="Verdana" Font-

Size="0.8em" PathSeparator=" : "> 

                            <PathSeparatorStyle Font-Bold="True" 

ForeColor="#990000" /> 

                            <CurrentNodeStyle ForeColor="#333333" /> 

                            <NodeStyle Font-Bold="True" ForeColor="#990000" /> 

                            <RootNodeStyle Font-Bold="True" 

ForeColor="#FF8000" /> 

                        </asp:SiteMapPath> 

  

  

Si sa punem si un „tree view” in loc de „right menu”: 

<asp:TreeView ID="TreeView1" runat="server" DataSourceID="SiteMapDataSource1" 

MaxDataBindDepth="1"> 

                        </asp:TreeView> 

                        <asp:SiteMapDataSource ID="SiteMapDataSource1" 

runat="server" /> 

mailto:ignatandrei@yahoo.com?subject=Tutorial%20programare%20in%20.NET%20
http://www.serviciipeweb.ro/iafblog


Tutorial programare in .NET   Ignat Andrei 

http://www.serviciipeweb.ro/iafblog Page 59 
 

  

  

  

Acum , daca veti rula proiectul si va duceti pe „new” veti vedea urmatoarele: 

 

  

  

Sigur ca linkul „All books” nu e implementat – dar ramine in sarcina dvoastra sa il faceti. 

  

Acum sa trecem la localizare. Vrem sa fim capabili ca cei care vin sa poata alege intre Engleza si 
Franceza 

O sa facem acest lucru pentru o singura forma, iar celelalte o sa le lasam ca exercitiu .  

O sa salvam setarea limbajului intr-un „cookie” pe PC-ul user-ului si o sa fie citit de fiecare data 
cind user-ul intra pe site. 

Sa adaugam un ”drop down list” pe „Book.master” : 

<asp:DropDownList runat="server" id="ddlLanguage" 

OnSelectedIndexChanged="ddlLanguage_SelectedIndexChanged" AutoPostBack="true"> 

                            <asp:ListItem Text="English" Value="en"> 

                            </asp:ListItem> 

                            <asp:ListItem Text="French" Value="fr"> 
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                            </asp:ListItem> 

                        </asp:DropDownList> 

  

  

In pagina.cs sa salvam setarea : 

protected void ddlLanguage_SelectedIndexChanged(object sender, EventArgs e) 

    { 

        HttpCookie cookie = Request.Cookies["Language"]; 

        cookie.Value = ddlLanguage.SelectedValue; 

        Response.AppendCookie(cookie); 

        cookie.Expires = System.DateTime.Now.AddYears(1); 

        Response.Redirect(Request.Url.LocalPath); 

    } 

  

  

  

Acum, ca am salvat-o , sa o regasim: 

protected void Page_Load(object sender, EventArgs e) 

    { 

        if (!IsPostBack) 

            ChangeLanguage(); 

  

    } 

    private void ChangeLanguage() 

    { 

        HttpCookie cookie = Request.Cookies["Language"]; 
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        if (cookie == null) 

        { 

            //set default the cookie in web.config 

            string s = Thread.CurrentThread.CurrentUICulture.Name; 

            cookie = new HttpCookie("Language"); 

            cookie.Value = s; 

            cookie.Expires = System.DateTime.Now.AddYears(1); 

            Response.AppendCookie(cookie); 

        } 

  

  

        foreach (ListItem li in ddlLanguage.Items) 

        { 

            if (li.Value == cookie.Value) 

            { 

li.Selected = true; 

                 break;             

} 

  

        } 

  

    } 
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Ca sa schimbam ar trebui sa scriem cod in fiecare pagina pe metoda  InitializeCulture , sau sa o 

punem in global.asax file( care prinde evenimentele aplicatiei ) pe Application_BeginRequest: 

(adaugati  „new item” => „Global Application Class”) 

  

    protected void Application_BeginRequest(object sender, EventArgs e) 

    { 

        string lang = 

System.Threading.Thread.CurrentThread.CurrentUICulture.Name; 

        HttpCookie cookie = Request.Cookies["Language"]; 

  

        if (cookie != null && cookie.Value != null) 

            lang = cookie.Value; 

  

        System.Threading.Thread.CurrentThread.CurrentUICulture = 

System.Globalization.CultureInfo.GetCultureInfo(lang); 

        System.Threading.Thread.CurrentThread.CurrentCulture = 

System.Globalization.CultureInfo.CreateSpecificCulture(lang); 

    } 

  

  

In sfirsit trebuie sa creeam textele in franceza si engleza. 

Adaugati un  folder Asp.NET, numit “App_LocalResources” 
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Si in acest folder adaugati trei fisiere de resurse, numite : 

frmPublisherList.aspx.en.resx 

frmPublisherList.aspx.fr.resx 

frmPublisherList.aspx.resx 

(Numele fisierului este compus din numele fisierului aspx + (optional) limba + .resx ) 

In aceste fisiere vom scrie un singur string de demo pentru  butonul „new”,ca in figura: 
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Iar codul de pe butonul „New” se va imbogati cu  meta:resourcekey="btnNew" : 

<asp:Button ID="btnNew" runat="server" Text="New" OnClick="btnNew_Click" 

meta:resourcekey="btnNew"/>     

  

Si , daca rulati aplicatia si schimbati in dropdown din Engleza in Franceza o sa vedeti textul 
butonului schimbindu-se 

Observatie 1:  Daca nu aveti fisierul .resx fara a specifica limbanu merge! 

Observatie 2: Daca aveti mai multe text IDENTICE de translatat  (exemplu : butonul de „save” ) 
putei adauga resurse resx in folder-ul App_GlobalResources. Exemplu : presupunem ca avem in 

App_GlobalResources fisierele : 

Buttons.en.resx 

Buttons.fr.resx 

Buttons.resx 

Si vrem sa modificam btnSaveText  

Accesam resursele astfel : 

  

<%$ Resources:Buttons,btnSaveText%> 
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<asp:Button ID="btnSave" Text="<%$ Resources:Buttons,btnSaveText%>" 

runat="server" OnClick="btnSave_Click" /> 

Sau, daca vreti in mod programatic: 

Resources.Buttons.btnSaveText 

  

Lecturi recomandate: 

Localization: http://quickstarts.asp.net/QuickStartv20/aspnet/doc/localization/localization.aspx 

Master Pages: 

http://quickstarts.asp.net/QuickStartv20/aspnet/doc/masterpages/default.aspx 

Programarea in .NET - partea a 10-a: Un proiect Dos   

Deschideti solutia book.sln si adaugati un nou proiect de tipul ConsoleApplication (nume :  
BookDos) 

Adaugati o referinta la proiectul BookObjects si adaugati un fisier app.config si scrieti in el 

aceleasi lucruri ca si in app.config file din proiectul BookWin. 

La fel pentru evenimentul de „post build” – deoarece trebuie sa copiem fisierul mdb : 

copy $(ProjectDir)..\BookData\*.mdb $(TargetDir) 

In Program.cs file scrieti urmatorul cod: 

using System; 

using System.Collections.Generic; 

using System.Text; 

using BookObjects; 

  

namespace BookDos 

{ 

    class Program 
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    { 

        static void Main(string[] args) 

        { 

            ColPublisher col = new ColPublisher(); 

            col.Load(); 

            Console.WriteLine("Records Number:" + col.Count); 

            foreach (Publisher p in col) 

            { 

                Console.WriteLine(p.Name); 

            } 

        } 

    } 

} 

  

  

Si, desigur, numar de inregistrari va fi 0- caci nu avem nici o inregistrare.  

La fel ca in proiectul Windows, puteti creea un nou Publisher, sterge, etc.  
 

Programarea in .NET - partea a 11-a Teste automate cu NUnit  
De ce ar trebui sa faceti teste automate ?  

Din mai multe motive : 

1.      Pentru ca e o modalitate usoara de a releva functionalitatile mari ale 
aplicatiei 

2.      Pentru ca la orice modificare la care nu sunteti sigur daca dauneaza cumva 

logicii aplicatiei puteti rula testele vechi si vedeti daca ati stricat ceva sau 
nu(Nota : ar trebui sa adaugati un nou test pentru cei care vin dupa voi )  
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3.      E mai usor de fixat bug-urile daca, pe deasupra, rulati testele in fiecare 

noapte – si a doua zi dimineata vedeti ceva stricat...  

4.        

Hai sa trecem la treaba: 

  

Mai intii downloadati NUnit de la http://www.nunit.org/index.php?p=download ( eu am folosit 

versiunea 2.2.8 )Exista si surse si setup de instalare. Eu as sfatui sa luati sursele sa le compilati.  

Apoi la solutia noastra Book.sln adaugam un nou proiect de tipul Class Library , numit BookTest 
, adaugam o referinta la nunit.framework.dll , aflat in NUnit-2.2.8-
src\src\NUnitFramework\framework\bin\Debug2005, modificam class1.cs in TestPublisher.cs si 

incepem sa scriem testul.Testul cel mai simplu este unul de CRUD – create , read, update, delete. 

Avem nevoie de obiectele Publisher respective, precum si de setari in fisierul App.Config pentru 
a recunoaste Baza de date, precum si de Baza de date.  

Pentru Publisher, adaugam o referinta la BookObject in tab-ul „Projects” de la Add Reference.  

Pentru App.Config, adaugam un fisier de tipul application configuration file si copiem de la 

BookDos partile relevante, astfel incit fisierul arata astfel :  

  

<?xml version="1.0" encoding="utf-8" ?> 

<configuration> 

<appSettings> 

<add key="DatabaseUsed" value="MDB"/> 

<!-- possible values : MDB, SQLServer--> 

</appSettings> 

<connectionStrings> 

<add name="MDB" connectionString="Provider=Microsoft.Jet.OLEDB.4.0;Data 

Source=|DataDirectory|\book.mdb;User Id=admin;Password=;"/> 

<!-- TODO : add for asp.net application the connection string with SQL Server-

-> 

</connectionStrings> 
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</configuration> 

  

Pentru baza de date, e simplu : in Build Events, la Post Build Command Line adaugam  

copy $(ProjectDir)..\BookData\*.mdb $(TargetDir) 

Acum putem incepe sa scriem testul : 

  

  

using System; 

using System.Collections.Generic; 

using System.Text; 

using NUnit.Framework; 

using BookObjects; 

namespace BookTest 

{ 

[TestFixture] //arata ca e o clasa care contine teste 

public class TestPublisher 

{ 

[Test] //arata ca metoda care urmeaza este un test 

[Category("CRUD")] //categoria -de obicei, testele de CRUD ar trebui puse 

impreuna 

public void CRUD() 

{ 

Publisher p = new Publisher(); 

p.Name = "Amazon"; 

p.Save(); 
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//sa il gasim 

ColPublisher cp = new ColPublisher(); 

cp.Load(); 

bool bFound= false; 

foreach (Publisher pLoop in cp) 

{ 

if (pLoop.Name == p.Name) 

{ 

bFound = true; 

break; 

} 

} 

//daca acea conditie(bFound) nu e true, atunci se afiseaza mesajul de eroare 

Assert.IsTrue(bFound, "Nu s-a gasit publisher cu numele " + p.Name + " dupa 

insert"); 

//sa il modificam 

p.Name = "O'Reilly"; 

p.Update(); 

  

//sa il gasim din nou 

cp = new ColPublisher(); 

cp.Load(); 

bFound = false; 

foreach (Publisher pLoop in cp) 

{ 

if (pLoop.Name == p.Name) 
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{ 

bFound = true; 

break; 

} 

} 

//daca acea conditie(bFound) nu e true, atunci se afiseaza mesajul de eroare 

Assert.IsTrue(bFound, "Nu s-a gasit publisher cu numele " + p.Name + " dupa 

update"); 

  

//acum sa il stergem  

p.Delete(); 

  

//si sa vedem ca nu a fost gasit 

cp = new ColPublisher(); 

cp.Load(); 

bFound = false; 

foreach (Publisher pLoop in cp) 

{ 

if (pLoop.Name == p.Name) 

{ 

bFound = true; 

break; 

} 

} 

  

//daca acea conditie(bFound) nu e false, atunci se afiseaza mesajul de eroare 
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Assert.IsFalse(bFound, "S-a gasit publisher cu numele " + p.Name + " dupa 

delete"); 

  

  

  

} 

} 

} 

  

  

Il compilam si sa rulam testul. Gasiti in folderul NUnit-2.2.8-src\src\GuiRunner\nunit-gui-
exe\bin\Debug2005 un nunit-gui.exe si porniti- l.Apasati File=> Open si mergeti in 

C:\Book\BookTest\bin\Debug si incarcati BookTest.dll . Ar trebui sa apara figura urmatoare  
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Apasati pe RUN si primul lucru pe care il vedeti este: 

 

  

  

Se vede clar ca e ceva prost... ne uitam in TestPublisher.cs si vedem ca la linia 37 este  

p.Update(); 

Ceva a mers prost la update ... sa vedem linia 107 din Publisher.cs  

strSQL += "'" + this.Site.Replace("'", "''") + "'"; 

Acum e clar ce s-a intimplat ... Cind am facut testul, nu am initializat Site-ul cu nimic... si atunci 
este null , ceea ce inseamna ca .Replace nu poate fi aplicat 

Sa modificam codul din Publisher.cs ca sa ia in seama si acest lucru :  

if (this.Site == null) 

strSQL += " NULL "; 

else 

strSQL += "'" + this.Site.Replace("'", "''") + "'"; 

  

Acum apare alta eroare : 
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Este destul de clar ca aplicatia nu a updatat numele ...  

De ce ?Ne dam seama imediat : in momentul in care aplicatia a adaugat un nou Publisher , nu a 

regasit ID-ul inserat ... iar cind a facut update, IDPublisher este 0 , ceea ce inseamna ca nu a 

putut fi facut update corect.  

Cum modificam acest lucru ? Pentru access , putem sa selectam maxim de ID,iar pentru SQL 
Server putem crea o procedura stocata ... sau sa intoarcem @@Identity 

Hai sa facem pentru Access , modificand Publisher.cs, procedura Save, adaugind la final:  

if(Settings.TheDatabase == Settings.DatabaseUsed.MDB) 

{ 

  

strSQL = "select max(IDPublisher) as nr from Publisher"; 

using (DbConnection dc = Settings.TheConnection) 

{ 

dc.Open(); 

using(DbCommand dco =Settings.TheCommand) 

{ 
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dco.CommandType = System.Data.CommandType.Text; 

dco.CommandText = strSQL; 

dco.Connection = dc; 

object o = dco.ExecuteScalar(); 

this.IDPublisher = int.Parse(o.ToString()); 

} 

} 

} 

Acum rulam din nou testul si totul e verde , ceea ce e de bine : 

 

  

  

E clar ca exemplu a fost mai degraba simplut, iar ceea ce conteaza, de fapt, sunt regulile de 

business si de validare - ca de exemplu, validarea CNP  

Programarea in .NET - partea a 12-a Documentarea - Scrierea de fişiere 

Help. 
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In .NET sunt doua tipuri mari de fişiere Help : Cele care produc Help pentru utilizatorul final si 

cele care sunt auto-generate din comentarii la cod. 

  

Avem nevoie de următoarele: 

1.Html Help Workshop – e free si puteţi sa îl downloadati de aici 

http://www.microsoft.com/downloads/details.aspx?familyid=00535334-c8a6-452f-9aa0-

d597d16580cc&displaylang=en. Adiţional puteţi downloada si fişiere css stil Office de aici 

http://www.microsoft.com/downloads/details.aspx?FamilyId=A6A76073-0E0A-49BB-8E21-
318B798B4CF6&displaylang=en 

  

  

2. Pentru documentaţia codului exista înainte NDoc – dar din păcate dezvoltatorul nu mai face 

dezvoltarea pentru .Net 2.0( vezi http://johnsbraindump.blogspot.com/2006/07/ndoc-20-is-
dead.html) 

Alternativa este SandCastle (http://www.sandcastledocs.com) din care ultimul CTP(Martie) este 
aici (http://www.microsoft.com/downloads/details.aspx?FamilyID=E82EA71D-DA89-42EE-

A715-696E3A4873B2&displaylang=en).  

  

3.De asemenea, pentru ca SandCastle e greu de utilizat din command line, exista mai multe GUI-
uri pentru el – intre care vom lucra cu SandCastle Help File Builder de pe CodePlex 

(http://www.codeplex.com/Wiki/View.aspx?ProjectName=SHFB). O sa lucram cu ultimul 
release ,1.4.0.1 PROD aflat aici 

http://www.codeplex.com/SHFB/Release/ProjectReleases.aspx?ReleaseId=2264  

si as downloada chiar sursele ...  

  

Începem cu documentarea codului pentru BookObjects, urmând sa trecem la generarea de Help 

pentru proiectul Windows. 
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Comentariile in C# se fac scriind trei slash-uri deasupra clasei/metodei/cimpului pe care vreţi sa 

le documentaţi: 

/// <summary> 

/// Aceasta clasa tine toti publisher-ii 

/// Mod de utilizare : folositi Load 

/// </summary> 

public class ColPublisher : 

System.Collections.ObjectModel.KeyedCollection<string,Publisher> 

{ 

  

/// <summary> 

/// varianta interna de generat cheie unica pentru un Publisher 

/// </summary> 

/// <param name="item">publisher-ul</param> 

/// <returns></returns> 

protected override string GetKeyForItem(Publisher item) 

{ 

Continuaţi cu toate metodele sau downloadati ultima varianta de proiect de aici: 

http://serviciipeweb.ro/iafblog/content/binary/part12/book.zip  

  

In plus, trebuie sa mai setaţi faptul ca trebuie generata documentaţia XML din proprietatile 
proiectului: 
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Acum in folder-ul C:\Book\BookObjects\bin\Debug aveţi generata documentaţia XML. Pornim 

SandCastle Help File Builder care arata cam asa: 
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Apăsam pe Add si ne ducem in C:\Book\BookObjects\bin\Debug. Acolo indicam dll-ul generat 

iar programul o sa „observe” si fişierul XML. Apăsam pe iconiţa de compilare si ... eroare...  

Error: Unresolved assembly reference: System.Configuration (System.Configuration, 
Version=2.0.0.0, Culture=neutral, PublicKeyToken=b03f5f7f11d50a3a) required by BookObjects  

Last step completed in 00:00:02.403 

  

  

După descriere vedem că ii lipseşte o referinţa la System.Configuration. Acest dll se afla in GAC 

(Global Assembly Cache) si o vom adăuga. In Project Properties , la Build=>Dependencies 
apăsaţi pe butonul cu cele 3 puncte.  

Acum in ecranul următor exista un buton cu imaginea de folder si cu o icoana de o cheie care 

iese, iar la tooltip scrie „Add GAC dependencies” 
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Apăsaţi pe el si căutaţi System.Configuration, Version=2.0.0.0, Culture=neutral, 

PublicKeyToken=b03f5f7f11d50a3a in lista care urmează.  

  

Acum rulati din nou si ceea ce se va genera este un document chm , numit Documentation.chm 
aflat in C:\Book\BookObjects\bin\Debug\Help: 
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Putem personaliza ceea ce se generează destul de uşor, modificând setările de aici: 
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E clar acum ca aceasta documentaţie se poate regenera la cerere.Daca vreti help in forma 2.0(hxs) 
, downloadati Visual Studio 2005 SDK Version 4.0 de la adresa 
http://www.microsoft.com/downloads/details.aspx?FamilyID=51a5c65b-c020-4e08-8ac0-

3eb9c06996f4&DisplayLang=en 

  

Sa generam acum documentaţia pentru Windows Forms.  

Ar trebui pentru fiecare forma sa avem cate un Help – aşa ca o sa cream 3 fişiere HTML care o sa 
tina List, Add si Update. 

  

Vom crea un nou folder, numit HelpWindows, in C:\book\Help si vom pune in el cele 3 fişiere : 

add.htm,list.htm,update.htm. 

Pornim HTML Help Workshop, File=>New =>Project si daţi next. Adaugati fişierele htm s i 
apăsati pe Contents. Acceptaţi creerea unui nou fişier si apăsând pe iconiţa din stânga cu aspect 

de fişier adăugat la conţinut cele 3 fisiere, dindu- le numele corespunzătoare. Acum, după 
compilare, s-a generat un fişier chm. Haideţi sa îl integram cu ap licaţia Windows. 

  

  

Sarcina de a copia fişierul chm lângă executabil o las cititorului, având in vedere ca am mai făcut 

aşa ceva(Project=>Properties=>Build Events). Sa mergem la forma de list si sa adaugam din 
ToolBox un control HelpProvider. LA proprietati la HelpNameSpace puneti numele chm-ului. 

Acum pe forma, gasiti HelpKeyword on... (setati valoarea la list.htm) si HelpNavigator on...( 
setat la topic). Rulati, apasati F1 si iata fisierul de help! 

  

Puteti downloada ultimele surse de aici 

http://serviciipeweb.ro/iafblog/content/binary/part12/book.zip  

  

Lecturi utile: 

GAC http://www.codeproject.com/dotnet/DemystifyGAC.asp  
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MSHelp 2.0 http://www.helpware.net/mshelp2/h20.htm 

Programarea in .NET - partea a 13-a - Log-area operaţiilor cu log4net  
 

In orice aplicaţie este bine sa ţinem evidenta operaţiilor făcute de utilizator( ce a modificat sau 
chiar ce a văzut). In acest scop putem folosi fie mecanismul de trace din .net,  fie o soluţie 

proprie, fie Logging si Instrumentation Application Block(http://msdn2.microsoft.com/en-
us/library/ms998162.aspx), fie log4net(http://logging.apache.org/log4net/  

  

Vom utiliza in acest exemplu log4net .El suporta log-area operaţiilor in felurite moduri – in fişier, 

baza de date, email, telnet si multe altele.  

Downloadati versiunea 1.2.10 de la adresa http://logging.apache.org/log4net/downloads.html si 
sa începem configurarea aplicaţiei. Copiaţi conţinutul folder-ului log4net-

1.2.10\bin\net\2.0\debug in C:\Book\sharedDll si sa începem modificarea proiectului Windows 
pentru a înregistra ce a făcut utilizatorul 

  

Deschidem Book.sln si deschidem App.Config. Acolo scriem următoarele imediat sub 

configuration: 

  <configSections> 

    <section name="log4net" 

type="log4net.Config.Log4NetConfigurationSectionHandler, log4net"/> 

  </configSections> 

  <log4net> 

    <appender name="RollingLogFileAppender" 

type="log4net.Appender.RollingFileAppender"> 

      <File value="Log4Net.log"/> 

      <AppendToFile value="true"/> 

      <rollingStyle value="Composite"/> 

      <maximumFileSize value="1MB"/> 

      <maxSizeRollBackups value="10"/> 

      <datePattern value="yyyyMMdd"/> 
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      <layout type="log4net.Layout.PatternLayout"> 

        <param name="ConversionPattern" value="%d [%t] %-5p %c %m%n"/> 

      </layout> 

    </appender> 

    <root> 

      <level value="Debug"/> 

      <appender-ref ref="RollingLogFileAppender"/> 

    </root> 

  </log4net> 

  

  

După cum se vede, folosim RollingLogFileAppender ( adică un fişier a cărui denumire va fi 
diferita in fiecare zi după modelul datePattern ) de tipul Composite(daca depaseste  

maximumFileSize atunci se creează un nou fişier in ziua respectiva).  

  

Sa adăugam referinţa proiectului nostru (BookWin) dll-ul log4net.dll din sharedDll .Avem de 
făcut următoarele in Program.cs : 

In funcţia Main scriem prima linie: 

log4net.Config.XmlConfigurator.Configure(); 

apoi adăugam următorul membru in clasa Program: 

public static readonly log4net.ILog logger = 

log4net.LogManager.GetLogger("RollingLogFileAppender"); 

  

Haide sa scriem in fişier de cite ori un utilizator adaugă un nou Publisher.  

In frmPublisherAdd.cs, la evenimentul private void btnAdd_Click(object sender, 

EventArgs e) vom adăuga codul de log-are: 

if (Program.logger.IsDebugEnabled) 
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                Program.logger.Debug("Adaugat publisher cu numele:" + p.Name); 

  

Cam atit e de făcut. Acum rulaţi proiectul, adaugaţi un Publisher, si o sa vedeţi un fişier 

log4Net.log in care scrie următoarele: 

  

<data> [1] DEBUG RollingLogFileAppender Adaugat publisher cu numele:newpub  

  

  

E interesant la log4Net ca puteţi adăuga mai mulţi appender-i, astfel ca , de pilda, sa trimită si 
email de cate ori o modificare e făcuta.  

 Observatie 1: 

Pentru aplicatia Web, modificarile in Web.Config sunt aceleasi - iar in global.asax trebuie pusa 
linia urmatoare: 

 void Application_Start(object sender, EventArgs e)  
    { 

        // Code that runs on application startup        
        log4net.Config.XmlConfigurator.Configure();     

    } 
 

Observatie 2: 

In loc sa punem codul in fiecare pagina de Web si Windowspe salvare, mai bine punem in fiecare 

cod de "salvare" al obiectelor- de pilda in public void Save() 
 
 

Lectura obligatorie: documentaţia de log4net... 
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Programarea in .NET - partea a 14-a Salvare XML si Executare de operatii 

asincrone in Windows Forms 
 

De ce taskuri asincrone ? In ideea ca , intr-o aplicatie Windows(si chiar ASP.NET) , operatiile lungi ar 

trebui sa fie executate de catre alt thread, urmind ca aplicatia sa poata sa mai afiseze ceva utilizatorulu in 

tot acest timp ( fie si un buton pe care scrie „apasa ca sa intrerupi operatia asta lunga ...”). De pilda, in 

aplicatia noastra, daca avem mai mult de 100 de Publisher-i si vrem sa ii vedem pe toti – ar trebui 

incarcati intr-un nou thread. 

 

Ne ocupam mai intii de o aplicatie Windows Forms si pe urma de ASP.NET 

Un thread nu e greu de pornit. Hai sa vedem un exemplu: 

System.Threading.Thread t = new System.Threading.Thread(new 

System.Threading.ParameterizedThreadStart(StartAction)); 

            t.Start("obiect transmis"); 

 

 

public void StartAction(object o) 

        { 

            string s = o.ToString(); 

            System.Threading.Thread.Sleep(5000); 

            //executa actiunea 

            //trimite text 

            if (this.InvokeRequired) 

            { 

                this.Invoke((MethodInvoker)delegate() 

                 { 

                     this.Text = s; 

                 }); 

                //sau 

                //this.Invoke(new MethodInvoker(evenimentfaraparametri()); 
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                //this.Invoke(new EventHandler(btnDiscounts_Click)); 

                //this.BeginInvoke(new EventHandler(eveniment cu parametri)); 

            } 

            else 

                this.Text = s; 

        } 

 

 

Totusi, exista o problema – dintr-un thread nu se pot accesa DIRECT controale din alt thread – si de 

aceea avem instructiunea this. Invoke .Diferenta intre this.Invoke si este this.BeginInvoke 

aceea ca prima instructiune asteapta rezultatul actiunii, pe cind a doua doar executa si se intoarce 

imediat sa execute codul ramas. 

 

De aceea exista controlul numit BackgroundWorker – care asigura ca , din evenimentul propriu generat, 

sa accesezi orice obiect de pe forma. O sa facem acest lucru pentru salvarea in XML a colectiei de 

Publisher-i in format XML. 

.NET are o forma usoara de a salva o colectie/clasa in format XML , salvindu-i proprietatile. 

Vom utiliza modalitatea cea  mai usoara de a face acest lucru 

Marcam clasa Publisher si clasa colectie ColPublisher cu atributul de   [Serializable] : 

 

[Serializable] 

    public class ColPublisher : 

System.Collections.ObjectModel.KeyedCollection<string,Publisher> 

 

[Serializable] 

    public class Publisher 

 

Acum o sa facem serializarea obiectului Publisher: 

#region Serializer 

        /// <summary> 
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        /// instanta pentru lazy load 

        /// </summary> 

        private static XmlSerializer m_Serializer; 

        /// <summary> 

        /// serializator pentru obiectul publisher 

        /// </summary> 

        private static XmlSerializer Serializer 

        { 

            get 

            { 

                if (m_Serializer == null) 

                    m_Serializer = new XmlSerializer(typeof(Publisher)); 

 

                return m_Serializer; 

            } 

        } 

 

        /// <summary> 

        /// salveaza obiectul ca XML 

        /// </summary> 

        [XmlIgnore] 

        public string XML 

        { 

            get 

            { 

                StringBuilder sb = new StringBuilder(); 

                EncodingStringWriter sw = new EncodingStringWriter(sb, 

Encoding.Default); 

                XmlTextWriter xtw = new XmlTextWriter(sw); 
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                Serializer.Serialize(xtw, this); 

                return sb.ToString(); 

 

 

            } 

        } 

        /// <summary> 

        /// recreeeaza un Publisher dintr-un string XML 

        /// </summary> 

        /// <param name="XML">string care contine tot </param> 

        /// <returns></returns> 

        public static Publisher FromXML(string XML) 

        { 

            StringReader sr = new StringReader(XML); 

            return Serializer.Deserialize(sr) as Publisher; 

        } 

        #endregion 

 

 

     

Copiem apoi acelasi cod( cu citeva diferente) si pentru ColPublisher  

 

Citeva comentarii despre cod: 

De ce am pus [XmlIgnore] peste  public string XML ? Pentru a nu serializa si aceasta 

proprietate, dind astfel nastere la o nedorita recursivitate 

Ce e cu clasa EncodingStringWriter ? Este facuta pentru a putea schimba Encoding=ul- daca 

aveti de exemplu caractere speciale(diacritice) romanesti/franceze/etc. 

De ce metoda FromXML este statica- iar XML este pe instanta? Asa mi se pare normal – 

transformarea dintr-un obiect in XML sa apartina obiectului, iar din XML in obiect nu poate sa apartina 
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unui obiect( ah, daca as fi putut scrie this = Serializer.Deserialize(sr) as Publisher  !) - ci 

doar clasei. 

Nu se poate face codul mai „generic”? Ba da- una din deosebiri ar fi ca FromXML ar trebui sa fie 

pe instanta... 

 

 

Haideti acum in proiectul Windows sa serializam o colectie de Publisher-i.Pe forma 

frmPublisherList adaugam un buton btnSave, cu textul Save, dublu click si scriem urmatorul cod: 

private void btnSave_Click(object sender, EventArgs e) 

        { 

            BookObjects.ColPublisher col = 

colPublisherBindingSource.DataSource as BookObjects.ColPublisher; 

            string strSave = 

System.Environment.GetFolderPath(System.Environment.SpecialFolder.ApplicationD

ata); 

            strSave = Path.Combine(strSave, "pub.xml"); 

            File.WriteAllText(strSave, col.XML); 

            System.Diagnostics.Process.Start(strSave); 

        } 

 

 

Rulati proiectul, adaugati 2 publisher-i si apasati pe save. 

Este clar ca, daca sunt multi publisher-i, procesul poate deveni prea lung si blocheaza interfata. 

 

Haideti sa folosim background worker. Il adaugam din toolbox , il redenumim bgSave, dublu click. Luam 

codul din btnSave_Click, il adaugam la si pe urma scriem doar bgSave.RunWorkerAsync();  

 

private void btnSave_Click(object sender, EventArgs e) 

        { 

            bgSave.RunWorkerAsync(); 
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        } 

 

        private void bgSave_DoWork(object sender, DoWorkEventArgs e) 

        { 

            BookObjects.ColPublisher col = 

colPublisherBindingSource.DataSource as BookObjects.ColPublisher; 

            string strSave = 

System.Environment.GetFolderPath(System.Environment.SpecialFolder.ApplicationD

ata); 

            strSave = Path.Combine(strSave, "pub.xml"); 

            File.WriteAllText(strSave, col.XML); 

            System.Diagnostics.Process.Start(strSave); 

 

        } 

 

Linkuri recomandate: 

BackgroundWorker in .NET 1.1  

http://weblogs.asp.net/rosherove/articles/BackgroundWorker.aspx 

 

Programarea in .NET - partea a 15-a Operatii asincrone in ASP.NET si  

AJAX 
 

Sa discutam despre operatii asincrone in ASP.NET.  

Exista doua tipuri mari de operatii operatii asincrone  

1. Cele care se executa doar pentru operatii lungi , care iau ceva timp de executie, si pentru care 

user-ul trebuie instiintat de evolutia lor. 

2. Cele care trimit rapid o cerere la server si se intorc. 
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Pentru 1.,o solutie recomandata este sa puneti Async=true in codul de pagina si sa executati codul cu 

RegisterTaskAsync . Asta este interesant, pina cind ne dam seama ca modul de afisare al paginii este 

acelasi – adica este intirziata pina cind se termina toata de executat. 

 

Un exemplu bun gasiti aici 

http://msdn.microsoft.com/msdnmag/issues/05/10/WickedCode/#S5 

si aici 

http://msdn.microsoft.com/msdnmag/issues/07/03/WickedCode/default.aspx 

 

Totusi, as recomanda o alta abordare – pentru ca user-ul sa „vada” desfasurarea detaliata a actiunilor 

efectuate, as recomanda scrierea cu Response.Write intr-un div si ascunderea apoi a div-ului . 

Ceva de genul acesta: 

 

Pe pagina aspx, printre ultimele linii, ascunderea div-ului cu mesaje: 

  <script> 

var mesaje = document.getElementById('mesaje'); 

if(mesaje != null) 

    mesaje.style.display = 'none'; 

 </script> 

 

In codul paginii aspx putem pune cod de genul urmator: 

Response.Write("<div id='mesaje'>"); 

                Response.Write("Begin :" + DateTime.Now.ToString("yyyy MMM dd 

hh:mm:ss") + "<BR>"); 

                Response.Flush(); 

//executare prim task 

Response.Write("Generated prim task<BR>"); 

Response.Flush(); 
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//executare al doilea task 

Response.Write("Generated al doilea task<BR>"); 

Response.Flush(); 

//incheiere procedura... 

Response.Write("</div>"); 

Response.Flush(); 

 

 

Acest model se poate combina cu evenimente generate in cadrul task-ruilor astfel incit, daca task-urile 

dureaza prea mult, user-ul sa aiba totusi un feedback despre ceea ce se intimpla. 

 

Sa discutam acum despre 2, executarea de operatii rapide pe server. Sa dam un exemplu simplu, si 

anume cautarea de publisher dupa nume. Ar fi superb daca aplicatia noastra, la apasarea primei litere a 

publisher-ului, ar putea sa sugereze publisher-ii care incep cu litera respectiva. 

Pentru aceasta vom folosi Ajax, si vom folosi implementarea de AutoComplete de la Ajax Control Toolkit 

Mai intii ,trebuie sa downloadam Ajax1.0 de aici.  

 

Apoi va trebui sa modificam Web.Config astfel incit sa suporte Ajax.  

Asta inseamna ca o sa luam o mare parte din Web.Config-ul unui site Ajax si o sa il mutam la noi in site. 

Sa incepem :  

De la o configuration o sa luam 

<configSections> 

  <sectionGroup name="system.web.extensions" 

type="System.Web.Configuration.SystemWebExtensionsSectionGroup, 

System.Web.Extensions, Version=1.0.61025.0, Culture=neutral, 

PublicKeyToken=31bf3856ad364e35"> 

   <sectionGroup name="scripting" 

type="System.Web.Configuration.ScriptingSectionGroup, System.Web.Extensions, 

Version=1.0.61025.0, Culture=neutral, PublicKeyToken=31bf3856ad364e35"> 

    <section name="scriptResourceHandler" 

type="System.Web.Configuration.ScriptingScriptResourceHandlerSection, 
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System.Web.Extensions, Version=1.0.61025.0, Culture=neutral, 

PublicKeyToken=31bf3856ad364e35" requirePermission="false" 

allowDefinition="MachineToApplication"/> 

    <sectionGroup name="webServices" 

type="System.Web.Configuration.ScriptingWebServicesSectionGroup, 

System.Web.Extensions, Version=1.0.61025.0, Culture=neutral, 

PublicKeyToken=31bf3856ad364e35"> 

     <section name="jsonSerialization" 

type="System.Web.Configuration.ScriptingJsonSerializationSection, 

System.Web.Extensions, Version=1.0.61025.0, Culture=neutral, 

PublicKeyToken=31bf3856ad364e35" requirePermission="false" 

allowDefinition="Everywhere"/> 

     <section name="profileService" 

type="System.Web.Configuration.ScriptingProfileServiceSection, 

System.Web.Extensions, Version=1.0.61025.0, Culture=neutral, 

PublicKeyToken=31bf3856ad364e35" requirePermission="false" 

allowDefinition="MachineToApplication"/> 

     <section name="authenticationService" 

type="System.Web.Configuration.ScriptingAuthenticationServiceSection, 

System.Web.Extensions, Version=1.0.61025.0, Culture=neutral, 

PublicKeyToken=31bf3856ad364e35" requirePermission="false" 

allowDefinition="MachineToApplication"/> 

    </sectionGroup> 

   </sectionGroup> 

  </sectionGroup> 

 </configSections> 

 

De la system.web o sa luam 

<pages> 

   <controls> 

    <add tagPrefix="asp" namespace="System.Web.UI" 

assembly="System.Web.Extensions, Version=1.0.61025.0, Culture=neutral, 

PublicKeyToken=31bf3856ad364e35"/> 

   </controls> 

  </pages> 

Si 
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  <compilation debug="false"> 

   <assemblies> 

    <add assembly="System.Web.Extensions, 

Version=1.0.61025.0, Culture=neutral, PublicKeyToken=31bf3856ad364e35"/> 

    <add assembly="System.Design, Version=2.0.0.0, 

Culture=neutral, PublicKeyToken=B03F5F7F11D50A3A"/> 

    <add assembly="System.Web.Extensions.Design, 

Version=1.0.61025.0, Culture=neutral, 

PublicKeyToken=31BF3856AD364E35"/></assemblies> 

  </compilation> 

 

Apoi Handler-e si Module: 

  <httpHandlers> 

   <remove verb="*" path="*.asmx"/> 

   <add verb="*" path="*.asmx" validate="false" 

type="System.Web.Script.Services.ScriptHandlerFactory, System.Web.Extensions, 

Version=1.0.61025.0, Culture=neutral, PublicKeyToken=31bf3856ad364e35"/> 

   <add verb="*" path="*_AppService.axd" validate="false" 

type="System.Web.Script.Services.ScriptHandlerFactory, System.Web.Extensions, 

Version=1.0.61025.0, Culture=neutral, PublicKeyToken=31bf3856ad364e35"/> 

   <add verb="GET,HEAD" path="ScriptResource.axd" 

type="System.Web.Handlers.ScriptResourceHandler, System.Web.Extensions, 

Version=1.0.61025.0, Culture=neutral, PublicKeyToken=31bf3856ad364e35" 

validate="false"/> 

  </httpHandlers> 

  <httpModules> 

   <add name="ScriptModule" 

type="System.Web.Handlers.ScriptModule, System.Web.Extensions, 

Version=1.0.61025.0, Culture=neutral, PublicKeyToken=31bf3856ad364e35"/> 

  </httpModules> 

Apoi extensions si WebServer: 

 <system.web.extensions> 

  <scripting> 

   <webServices> 
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    <!-- Uncomment this line to customize maxJsonLength 

and add a custom converter --> 

    <!-- 

      <jsonSerialization maxJsonLength="500"> 

        <converters> 

          <add name="ConvertMe" type="Acme.SubAcme.ConvertMeTypeConverter"/> 

        </converters> 

      </jsonSerialization> 

      --> 

    <!-- Uncomment this line to enable the authentication 

service. Include requireSSL="true" if appropriate. --> 

    <!-- 

        <authenticationService enabled="true" requireSSL = "true|false"/> 

      --> 

    <!-- Uncomment these lines to enable the profile 

service. To allow profile properties to be retrieved 

           and modified in ASP.NET AJAX applications, you need to add each 

property name to the readAccessProperties and 

           writeAccessProperties attributes. --> 

    <!-- 

      <profileService enabled="true" 

                      readAccessProperties="propertyname1,propertyname2" 

                      writeAccessProperties="propertyname1,propertyname2" /> 

      --> 

   </webServices> 

   <!-- 

      <scriptResourceHandler enableCompression="true" enableCaching="true" /> 

      --> 

  </scripting> 

 </system.web.extensions> 
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 <system.webServer> 

  <validation validateIntegratedModeConfiguration="false"/> 

  <modules> 

   <add name="ScriptModule" preCondition="integratedMode" 

type="System.Web.Handlers.ScriptModule, System.Web.Extensions, 

Version=1.0.61025.0, Culture=neutral, PublicKeyToken=31bf3856ad364e35"/> 

  </modules> 

  <handlers> 

   <remove name="WebServiceHandlerFactory-Integrated"/> 

   <add name="ScriptHandlerFactory" verb="*" path="*.asmx" 

preCondition="integratedMode" 

type="System.Web.Script.Services.ScriptHandlerFactory, System.Web.Extensions, 

Version=1.0.61025.0, Culture=neutral, PublicKeyToken=31bf3856ad364e35"/> 

   <add name="ScriptHandlerFactoryAppServices" verb="*" 

path="*_AppService.axd" preCondition="integratedMode" 

type="System.Web.Script.Services.ScriptHandlerFactory, System.Web.Extensions, 

Version=1.0.61025.0, Culture=neutral, PublicKeyToken=31bf3856ad364e35"/> 

   <add name="ScriptResource" preCondition="integratedMode" 

verb="GET,HEAD" path="ScriptResource.axd" 

type="System.Web.Handlers.ScriptResourceHandler, System.Web.Extensions, 

Version=1.0.61025.0, Culture=neutral, PublicKeyToken=31bf3856ad364e35"/> 

  </handlers> 

 </system.webServer> 

 

Acum downloadam Ajax Control Toolkit si vom referentia controalele existente, aflate in 

AjaxControlToolkit-NoSource\SampleWebSite\Bin . Vom adauga un nou tab in ToolBox, ii vom zice 

AjaxControls si vom adauga itemii apasind pe Choose Items: 
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Si apoi indicind prin browse calea la AjaxControlToolkit.dll pe care l-am downloadat. Apasati pe urma OK 

si vom avea controalele Ajax. 

Trageti un AutoCompleteExtender si un textbox in frmPublisherList.aspx . 

 

Vom completa  

public class wsPublisher : System.Web.Services.WebService { 

cu atributul  

[System.Web.Script.Services.ScriptService] 

si vom adauga o metoda pentru regasirea publisher-ilor care incep cu o litera data: 

 

    [WebMethod] 

    public string[] GetCompletionPublishers(string prefixText, int count) 
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    { 

        if (count <= 0) 

            count = 10; 

 

        List<string> items = new List<string>(count); 

        BookObjects.ColPublisher publishers = new BookObjects.ColPublisher(); 

        publishers.Load(); 

        foreach (BookObjects.Publisher pub in publishers) 

        { 

            if (pub.Name.IndexOf(prefixText, 

StringComparison.CurrentCultureIgnoreCase) == 0) 

                items.Add(pub.Name); 

 

            if (items.Count == count) 

                break; 

        } 

        return items.ToArray(); 

 

    } 

 

 

O vom folosi in Autocomplete: 

<asp:ScriptManager runat="server"> 

    </asp:ScriptManager> 

    <asp:TextBox ID="txtPub" runat="server" autocomplete="off"></asp:TextBox> 

    <cc1:AutoCompleteExtender ID="AutoPub" runat="server" 

     

    TargetControlID="txtPub" 
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                ServicePath="wsPublisher.asmx"  

                ServiceMethod="GetCompletionPublishers" 

                MinimumPrefixLength="1"  

                CompletionInterval="1000" 

                EnableCaching="true" 

                CompletionSetCount="12"> 

    </cc1:AutoCompleteExtender> 

     

In momentul de fata putem testa aplicatia si vedea ca se listeaza numele publisher-ilor. 

 

 

Lucruri de facut: 

Creat o metoda prin care sa se poata incarca doar cei care au prefix, nu toti publisher-ii cum am facut in 

public string[] GetCompletionPublishers(string prefixText, int count)  

De pus scriptManager-ul in Master- ca sa nu fim nevoiti sa il punem in fiecare pagina. 

 

De vazut celelalte controale de la Ajax Control Toolkit (live demo la adresa 

http://ajax.asp.net/ajaxtoolkit/Default.aspx ) 

 

 

 

Data viitoare vom vorbi despre scoaterea de rapoarte . 

Programarea in .NET - partea a 16-a Rapoarte in ASP.NET  
 

Orice aplicatie trebuie sa aiba posibilitatea de a tipari datele. Pentru aceasta in VS2005 Express  se poate 

folosi componenta  Report Viewer care e free si se poate downloada de la 

http://www.gotreportviewer.com. 
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Dupa ce o instalati, o sa aveti in toolbox urmatoarea componenta: 

 

 

 

Acum adaugam un raport care sa fie afisat de catre aplicatie – deschidem aplicatia Web si adaugam un 

nou item de tipul Report si il numim rptPublisher.rdlc : 
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Acum adaugam un nou datasource apasand pe Add New DataSource 
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In ecranul urmator apasam pe NewConnection si selectam baza noastra de date: 
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Putem salva conexiunea in Web.Config(desi o mai avem) si apasam Next. Pe urmatorul ecran lasam 

selectat “Use SQL Statements” si iarasi Next. Acum scriem codul pentru SQL: 

 

SELECT     IDPublisher, NamePublisher, SitePublisher 

FROM         Publisher 
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si iarasi Next pina se termina ( sau direct Finish). 

 

Acum in WebSite DataSource ne-a aparut dataset-ul care contine Publisher 
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Ne ducem pe Toolbox si tragem pe rptPublisher.rdlc un Table 

Ne intoarcem pe WebSite DataSources si tragem Name Publisher pe detaliu: 

 

 

 

Acum sa verificam 

Cream o noua pagina aspx, frmPublisherReport.aspx si scriem urmatorul cod(sau tragem controlul de  

ReportViewer si ii spunem care e raportul) 

<%@ Page Language="C#" MasterPageFile="~/Book.master" AutoEventWireup="true" 

CodeFile="frmPublisherReport.aspx.cs" Inherits="frmPublisherReport" 

Title="Report Publisher" %> 

 

<%@ Register Assembly="Microsoft.ReportViewer.WebForms, Version=8.0.0.0, 

Culture=neutral, PublicKeyToken=b03f5f7f11d50a3a" 
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    Namespace="Microsoft.Reporting.WebForms" TagPrefix="rsweb" %> 

<asp:Content ID="Content1" ContentPlaceHolderID="ContentPlaceHolder1" 

Runat="Server"> 

    <rsweb:ReportViewer ID="rptPublisher" runat="server"> 

        <LocalReport ReportPath="rptPublisher.rdlc"> 

             

        </LocalReport> 

    </rsweb:ReportViewer> 

</asp:Content> 

 

In codul C# punem urmatoarele linii : 

using System; 

using System.Data; 

using System.Configuration; 

using System.Collections; 

using System.Web; 

using System.Web.Security; 

using System.Web.UI; 

using System.Web.UI.WebControls; 

using System.Web.UI.WebControls.WebParts; 

using System.Web.UI.HtmlControls; 

using Microsoft.Reporting.WebForms; 

 

public partial class frmPublisherReport : System.Web.UI.Page 

{ 

    protected void Page_Load(object sender, EventArgs e) 

    { 

        BookObjects.ColPublisher publishers = new BookObjects.ColPublisher(); 
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        publishers.Load();         

        ReportDataSource rds = new 

ReportDataSource("DataSet1_Publisher",publishers); 

         

        rptPublisher.ProcessingMode = ProcessingMode.Local; 

        rptPublisher.LocalReport.DataSources.Add(rds); 

        rptPublisher.LocalReport.Refresh(); 

 

    } 

 

     

} 

 

Si modificam fisierul rdlc deschizindu-l cu notepad-ul si scriind urmatoarele: 

<?xml version="1.0" encoding="utf-8"?> 

<Report xmlns="http://schemas.microsoft.com/sqlserver/reporting/2005/01/reportdefinition" 

xmlns:rd="http://schemas.microsoft.com/SQLServer/reporting/reportdesigner"> 

  <DataSources> 

    <DataSource Name="BookConnectionString"> 

      <ConnectionProperties> 

        <ConnectString /> 

        <DataProvider>SQL</DataProvider> 

      </ConnectionProperties> 

      <rd:DataSourceID>c649d533-64c3-42b6-9805-19adbfccd468</rd:DataSourceID> 

    </DataSource> 

  </DataSources> 

  <BottomMargin>1in</BottomMargin> 
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  <RightMargin>1in</RightMargin> 

  <rd:DrawGrid>true</rd:DrawGrid> 

  <InteractiveWidth>8.5in</InteractiveWidth> 

  <rd:SnapToGrid>true</rd:SnapToGrid> 

  <Body> 

    <ReportItems> 

      <Table Name="table1"> 

        <Footer> 

          <TableRows> 

            <TableRow> 

              <TableCells> 

                <TableCell> 

                  <ReportItems> 

                    <Textbox Name="textbox7"> 

                      <rd:DefaultName>textbox7</rd:DefaultName> 

                      <ZIndex>1</ZIndex> 

                      <Style> 

                        <PaddingLeft>2pt</PaddingLeft> 

                        <PaddingBottom>2pt</PaddingBottom> 

                        <PaddingRight>2pt</PaddingRight> 

                        <PaddingTop>2pt</PaddingTop> 

                      </Style> 

                      <CanGrow>true</CanGrow> 

                      <Value /> 

                    </Textbox> 

                  </ReportItems> 
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                </TableCell> 

              </TableCells> 

              <Height>0.45833in</Height> 

            </TableRow> 

          </TableRows> 

        </Footer> 

        <Left>0.5in</Left> 

        <DataSetName>DataSet1_Publisher</DataSetName> 

        <Top>0.25in</Top> 

        <Width>6.5in</Width> 

        <Details> 

          <TableRows> 

            <TableRow> 

              <TableCells> 

                <TableCell> 

                  <ReportItems> 

                    <Textbox Name="txtName"> 

                      <rd:DefaultName>Name</rd:DefaultName> 

                      <Style> 

                        <PaddingLeft>2pt</PaddingLeft> 

                        <PaddingBottom>2pt</PaddingBottom> 

                        <PaddingRight>2pt</PaddingRight> 

                        <PaddingTop>2pt</PaddingTop> 

                      </Style> 

                      <CanGrow>true</CanGrow> 

                      <Value>=Fields!Name.Value</Value> 
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                    </Textbox> 

                  </ReportItems> 

                </TableCell> 

              </TableCells> 

              <Height>0.45833in</Height> 

            </TableRow> 

          </TableRows> 

        </Details> 

        <Header> 

          <TableRows> 

            <TableRow> 

              <TableCells> 

                <TableCell> 

                  <ReportItems> 

                    <Textbox Name="textbox1"> 

                      <rd:DefaultName>textbox1</rd:DefaultName> 

                      <ZIndex>2</ZIndex> 

                      <Style> 

                        <PaddingLeft>2pt</PaddingLeft> 

                        <PaddingBottom>2pt</PaddingBottom> 

                        <PaddingRight>2pt</PaddingRight> 

                        <PaddingTop>2pt</PaddingTop> 

                      </Style> 

                      <CanGrow>true</CanGrow> 

                      <Value>Name</Value> 

                    </Textbox> 
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                  </ReportItems> 

                </TableCell> 

              </TableCells> 

              <Height>0.45833in</Height> 

            </TableRow> 

          </TableRows> 

        </Header> 

        <TableColumns> 

          <TableColumn> 

            <Width>6.5in</Width> 

          </TableColumn> 

        </TableColumns> 

        <Height>1.375in</Height> 

      </Table> 

    </ReportItems> 

    <Height>2in</Height> 

  </Body> 

  <rd:ReportID>9f0247a8-15fe-4ef9-962e-c4c670524163</rd:ReportID> 

  <LeftMargin>1in</LeftMargin> 

  <DataSets> 

    <DataSet Name="DataSet1_Publisher"> 

      <rd:DataSetInfo> 

        <rd:ObjectDataSourceType>Publisher</rd:ObjectDataSourceType> 

        <rd:TableName>Publisher</rd:TableName> 

      </rd:DataSetInfo> 

      <Query> 

mailto:ignatandrei@yahoo.com?subject=Tutorial%20programare%20in%20.NET%20
http://www.serviciipeweb.ro/iafblog


Tutorial programare in .NET   Ignat Andrei 

http://www.serviciipeweb.ro/iafblog Page 112 
 

        <rd:UseGenericDesigner>true</rd:UseGenericDesigner> 

        <CommandText /> 

        <DataSourceName>BookConnectionString</DataSourceName> 

      </Query> 

      <Fields> 

        <Field Name="IDPublisher"> 

          <rd:TypeName>System.Int32</rd:TypeName> 

          <DataField>IDPublisher</DataField> 

        </Field> 

        <Field Name="Name"> 

          <rd:TypeName>System.String</rd:TypeName> 

          <DataField>Name</DataField> 

        </Field> 

        <Field Name="Site"> 

          <rd:TypeName>System.String</rd:TypeName> 

          <DataField>Site</DataField> 

        </Field> 

      </Fields> 

    </DataSet> 

  </DataSets> 

  <Width>9.75in</Width> 

  <InteractiveHeight>11in</InteractiveHeight> 

  <Language>en-US</Language> 

  <TopMargin>1in</TopMargin> 

</Report> 
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Acum , rulind pagina, observam ca se poate exporta raportul in Excel si PDF – mai mult decit sufficient: 

 

 

 

Acelasi raport se poate vedea si cu SQL Server Reporting Services… 

 

 

Linkuri utile: 

http://www.gotreportviewer.com/ - in partea dreapta aveti exemple de aplicatii care fac diverse – 

genereaza automat fisierele rdlc, scot automat fisierele Excel si multe altele 

 

SQL Server Reporting Services – pentru utilizarea avansata a rapoartelor. 
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Programarea in .NET - partea a 17-a Rapoarte in ASP.NET –Windows 

Forms 
Haideti sa repetam ceea ce am facut in ASP.NET pentru WindowsForms 

Deschideti Book.sln, adaugati o noua forma in proiect(frmPublisherPrint.cs) si trageti ReportViewer in 

forma.(Daca nu il gasiti, click dreapta in Toolbox, alegeti “choose items” , cautati ReportViewer din 

namespace-ul Microsoft.Reporting.WinForms si selectati-l 

 

 

 

 

Adaugam raportul existent prin click dreapta pe BookWin 

mailto:ignatandrei@yahoo.com?subject=Tutorial%20programare%20in%20.NET%20
http://www.serviciipeweb.ro/iafblog


Tutorial programare in .NET   Ignat Andrei 

http://www.serviciipeweb.ro/iafblog Page 115 
 

 

 

Va duceti in BookWeb, alegeti din casuta “Files of type” ultima selectie “All files” si selectati 

rptPublisher.rdlc. 

Acum click pe el si in fereastra de proprietati alegeti la “Copy to output directory “ “Copy always” 
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Bun – acum au  ramas 3 lucruri de facut : vizualizarea formei ca actiune, legarea controlului de raportul 

existent si codul de incarcare a datelor in raport. 

 

Pentru vizualizarea formei ca actiune adaugati un buton btnPrint in frmPublisherList iar pe eveniment 

scrieti urmatorul cod: 

private void btnPrint_Click(object sender, EventArgs e) 

        { 

            frmPublisherPrint p = new frmPublisherPrint(); 

            p.ShowDialog(this); 

        } 

 

Pentru legarea controlului vom seta la proprietati calea catre raport(presupunem ca se va afla in acelasi 

folder) si processing mode la local 
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Ultimul lucru de facut – incarcarea colectiei pe evenimentul de load : 

rivate void frmPublisherPrint_Load(object sender, EventArgs e) 

        { 

            BookObjects.ColPublisher publishers = new 

BookObjects.ColPublisher(); 

            publishers.Load(); 

            MessageBox.Show(""+publishers.Count); 

            ReportDataSource rds = new ReportDataSource("DataSet1_Publisher", 

publishers); 

            rptPublisher.ProcessingMode = ProcessingMode.Local; 

            rptPublisher.LocalReport.DataSources.Clear(); 

            rptPublisher.LocalReport.DataSources.Add(rds);             

            rptPublisher.LocalReport.Refresh(); 

            rptPublisher.RefreshReport(); 

        } 

( exact acelasi cod ca la Web, in afara liniei : 

 

Ea previne cazul( des intilnit) in care editorul IDE adauga , cu de la sine putere, un ReportDataSource 

. 

Ceea ce se va infatisa va fi: 
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Ce mai e de facut 

1)frmPublisherPrint sa nu mai afiseze ce vrea ea  - ci sa primeasca un argument(in constructor, de 

exemplu) care sa spun ce lista de publisher-i are de afisat 

2) Avind in vedere ca rapoartele sunt aceleasi pentru Windows si Web , ar fi interesant de facut un dll 

care sa intoarca raport – ul cerut  
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